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1 Introduction

This manual provides basic knowledge required to use the
MCT 10 Set-up Software with Danfoss Drives VLT®

frequency converters. Familiarity with the following is
assumed:

• MS®-Windows™ at user level.

• Set-up, process knowledge, and operation of
frequency converters.

• Use of and linkage with communication
equipment.

The manual does not provide any detailed information
regarding specific applications or possible solutions and
related parameter combinations in the set-up and use of a
frequency converter. Refer to the operating guide and
design guide of the frequency converter. Any update of the
manual and instructions related to the MCT 10 Set-up
Software is available on the Danfoss Drives homepage:
www.drives.danfoss.com

Familiarity with the PC or PLC master of the system is
assumed. Issues regarding hardware or software produced
by other manufacturers are beyond the scope of this
manual and are not the responsibility of Danfoss.

Refer to the appropriate manuals for more information
about master-to-master communication, or communication
to a non-Danfoss slave.

1.1 Document and Software Version

This manual is regularly reviewed and updated. All
suggestions for improvement are welcome. Table 1.1 shows
the document version and the corresponding software
version.

Edition Remarks Software
version

MG10RCxx Upgrade to new software version. New

plug-ins and the VLT® Software
Customizer described.

4.10

Table 1.1 Document and Software Version

1.2 Intended Use

The MCT 10 Set-up Software enables full system configu-
ration and control. With MCT 10 Set-up Software, it is
possible to monitor the entire system more effectively for
faster diagnosis and better preventive maintenance.

MCT 10 Set-up Software is designed as an interactive
commissioning tool for quick and easy commissioning of
the following frequency converter series:

• VLT® 2800

• VLT® 4000

• VLT® 5000

• VLT® 6000

• VLT® 8000

• VLT® Micro Drive FC 51

• VLT® HVAC Basic Drive FC 101

• VLT® HVAC Drive FC 102

• VLT® Refrigeration Drive FC 103

• VLT® AQUA Drive FC 202

• VLT® Midi Drive FC 280

• VLT® AutomationDrive FC 301/FC 302

• VLT® AutomationDrive FC 360

• VLT® Decentral Drive FCD 302

• VLT® DriveMotor FCM Series

• VLT® Compressor Drive CD 302

• VLT® Compressor Drive CDS 302

• VLT® Compressor Drive CDS 303

• VLT® Soft Starter MCD 500

• VLT® Advanced Active Filter AAF 006

The MCT 10 Set-up Software can be used as follows:
• For planning a new communication network off-

line. The MCT 10 Set-up Software contains a
complete database with all Danfoss Drives
products.

• For commissioning frequency converters online.

• For easy replacement of a frequency converter.

• For easy expansion of network with more
frequency converters.

• For back-up of parameter settings of frequency
converters in a communication network.

• The MCT 10 Set-up Software supports PROFIBUS
DP-V1 communication via a master class 2
connection. This connection eliminates the need
for an extra communication network.

The communication framework part of MCT 10 Set-up
Software is handling the control of the fieldbusses. It
provides enhanced capabilities allowing multiple
concurrent fieldbus communication. Several fieldbusses can
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be configured and combined in the same network within
MCT 10 Set-up Software.

NOTICE
If several fieldbusses are created with the same type,
make sure that they are configured with different scan
ranges.

1.3 System Requirements

To use the MCT 10 Set-up Software, the IBM-compatible
personal computer must meet the following minimum
system requirements:

• A Pentium PIII 350 Mhz or compatible
microprocessor.

• 1 GB of RAM recommended.

• A CD-ROM drive.

• 1.4 GB of available space on the hard drive.

MCT 10 Set-up Software runs on the following MS
Windows versions:

• Windows™ 7 32/64 bit editions

• Windows™ 8 32/64 bit editions

• Windows™ 10 32/64 bit editions

1.4 Software Modules

The MCT 10 Set-up Software is supplied in 2 modules:
• MCT 10 Set-up Software for:

- Setting of the frequency converter
parameters.

- Copying of parameter sets to and from
a frequency converter.

- Documentation/printout of set-up,
including diagrams.

- Servicing and fault analysis.

• APoss program for:

- Creating APoss programs.

1.4.1 Features of MCT 10 Set-up Software

• Project-oriented PC tool, 1 tool for all frequency
converter series.

• Links to all Windows applications possible.

• Supports Siemens CP PCMCIA- and PCI cards, for
PROFIBUS DP-V1 master class 2 connection.

• Support of standard interfaces: COMx, USB, RS232
(Flux).

• Siemens PG/Field PGs already have the necessary
hardware.

• View is highly individually configurable.

• Downwards compatibility with Dos-Dialog (*.mnu)
and WinDialog (*.vlt).

• Windows™ Explorer-like interface for quick and
easy start-up and navigation.

e3
0b

t5
13

.1
2

Illustration 1.1 Connect up to 126 nodes using a repeater.
Without a repeater, connect up to 31 nodes.
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1.5 Versions

MCT 10 Set-up Software is available in 2 versions:
• MCT 10 Set-up Software Basic is available free of

charge, downloadable from www.vlt-software.com

• MCT 10 Set-up Software Advanced can be
purchased with the ordering number 130B1000.

Version supports MCT 10 Set-up
Software Advanced

MCT 10
Set-up
Software
Basic

Frequency converters per
project

Unlimited 4

FC protocol ✓ ✓
Functional safety ✓ ✗
USB ✓ ✓
PROFIBUS DP-V1 ✓ ✓
PROFIBUS DP-V1
Handling multiple Danfoss
nodes concurrently

✓ (improved
performance)

✗

Ethernet-TSC ✓ ✓
Logging and scope function 8 channels 2

channels

Real-time logging from
frequency converter

4 channels ✗

Alarm display ✓ View only

VLT® Motion Control Option
MCO 305

✓ ✓

Graphical smart logic control ✓ ✓
VLT® 5000 to FC 302, VLT®

6000 to FC 102, and VLT®

2800 to FC 280 conversion
wizards

✓ ✓

FC to FC conversion wizard ✓  

Import 3000.XLS to FC 302 ✓ ✗
Motor database ✓ ✗
VLT® Extended Cascade
Controller MCO 101

✓ ✗

Drive file system ✓ ✗

VLT® Wireless Control Panel
LCP 103

✓ ✓

Status plug-in ✓ ✓

Drive plug-in ✓ ✗

VLT® Software Customizer ✓ ✗

Table 1.2 Features of the Basic and Advanced Versions

1.6 Further Information

The following documents related to MCT 10 Set-up
Software are available.

• VLT®  PROFIBUS DP-V1 MCA 101 Installation Guide.

• Design guide for the relevant frequency
converters.

Refer to drives.danfoss.com for frequently asked questions
and additional information.
It is also possible to find video training material on this site
for operating MCT 10 Set-up Software.
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2 Safety

2.1 Safety Symbols

The following symbols are used in this guide:

WARNING
Indicates a potentially hazardous situation that could
result in death or serious injury.

CAUTION
Indicates a potentially hazardous situation that could
result in minor or moderate injury. It can also be used to
alert against unsafe practices.

NOTICE
Indicates important information, including situations that
can result in damage to equipment or property.

2.2 Safety Precautions

WARNING
HIGH VOLTAGE
Frequency converters contain high voltage when
connected to AC mains input, DC supply, or load sharing.
Failure to perform installation, start-up, and maintenance
by qualified personnel can result in death or serious
injury.

• Only qualified personnel must perform instal-
lation, start-up, and maintenance.

• Before performing any service or repair work,
use an appropriate voltage measuring device to
make sure that there is no remaining voltage on
the drive.

WARNING
UNINTENDED START
When the frequency converter is connected to AC mains,
DC supply, or load sharing, the motor may start at any
time. Unintended start during programming, service, or
repair work can result in death, serious injury, or
property damage. The motor can start via an external
switch, a fieldbus command, an input reference signal
from the LCP, or after a cleared fault condition.

To prevent unintended motor start:
• Disconnect the frequency converter from the

mains.

• Press [Off/Reset] on the LCP before
programming parameters.

• Completely wire and assemble the frequency
converter, motor, and any driven equipment
before connecting the frequency converter to
AC mains, DC supply, or load sharing.

WARNING
DISCHARGE TIME
The frequency converter contains DC-link capacitors,
which can remain charged even when the frequency
converter is not powered. High voltage can be present
even when the warning LED indicator lights are off.
Failure to wait the specified time after power has been
removed before performing service or repair work can
result in death or serious injury.

• Stop the motor.

• Disconnect AC mains and remote DC-link power
supplies, including battery back-ups, UPS, and
DC-link connections to other frequency
converters.

• Disconnect or lock PM motor.

• Wait for the capacitors to discharge fully. The
minimum duration of waiting time is specified
in the frequency converter operating guide.

• Before performing any service or repair work,
use an appropriate voltage measuring device to
make sure that the capacitors are fully
discharged.

For further information, see drives.danfoss.com/
downloads/pc-tools/#/

Safety VLT® Motion Control Tools MCT 10 Set-up Software
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3 Installation and De-installation

3.1 Introduction

The MCT 10 Set-up Software and SyncPos modules are
installed via a multilingual, self-explanatory installation
program.

3.1.1 Start the Installation Program

1. Select the submenu Run from File in Windows
programming control.

2. Enter: [DRIVELETTER]:\SETUP in the command line
and press <Return>.

3. Follow the instructions of the installation
program.

When the installation process is complete, the MCT 10 Set-
up Software can be found on the following path:

e3
0b

t5
14
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2

Illustration 3.1 Path for MCT 10 Set-up Software

3.1.2 MCT 10 Set-up Software Language

The default language for the MCT 10 Set-up Software is
English. Change the language of operation as follows.

1. Select Options from the main menu, then select
Language.

2. Select the wanted language from the scrollbar
and close the window.

3. Close and restart MCT 10 Set-up Software to
activate the language setting.

Change language
Select the language version during installation.

NOTICE
The selected language is the new default language.

e3
0b

t5
15
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2

Illustration 3.2 Select Language

NOTICE
Change of language affects parameter language. If an
external LCP display is connected to the frequency
converter, the change of language version does not
affect the language in the display.

3.1.3 De-installation

NOTICE
The following procedure is only valid for a Windows
operating system.

1. Select Start.

2. Select Settings.

3. Select Control Panel.

4. Double-click Remove/Add Programs.

5. Select Remove.

Installation and De-install... Operating Guide
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4 Set-up of Communication

4.1 Communication Options

Danfoss frequency converters in the VLT® HVAC Drive FC
102, VLT® AQUA Drive FC 202, and VLT® AutomationDrive
FC 302 series are equipped with a USB port. Communi-
cation from a PC can be established using a standard A – B
male-to-male USB cable connected to the frequency
converter. No extra hardware or bus configuration is
required. If the PC is equipped with more than 1 USB port,
several frequency converters can be connected. The USB
bus is automatically added to the network bus list.

Establish a hardwired connection through:
• Standard built-in RS485, or

• USB port.

The USB interface socket allows devices to be connected
and disconnected using hot swapping. When connecting a
frequency converter using USB, MCT 10 Set-up Software
automatically adds on to the bus list.

If the VLT® PROFIBUS DP-V1 MCA 101 or VLT® EtherNet/IP
MCA 121 option is mounted in the frequency converter,
establish the connection through:

• PROFIBUS master class 2 connection (MSAC 2), or

• Ethernet-based network.

NOTICE
Soft starters can only be connected through a USB cable.

NOTICE
RISK OF DAMAGE TO PC USB HOST
CONTROLLER
When connecting the PC to the frequency converter
through the USB cable, there is a risk of damaging the
PC USB host controller.

• Follow the recommendations for grounding
described in the operating guide for the relevant
frequency converter.

• Use a USB isolator with galvanic isolation to
protect the PC USB host controller from ground
potential differences when connecting the PC to
a frequency converter through a USB cable.

• Do NOT use a PC power cable with a ground
plug when the PC is connected to the frequency
converter through a USB cable.

Communication from a PC can be established via RS232 to
RS485 converters or via USB to RS485 converters.

e3
0b

t6
31

.1
1

Illustration 4.1 Communication from a PC

4.2 Manual Fieldbus Configuration

After installation, configure the non-plug-and-play
networks via the fieldbus configuration dialog.

e3
0b

t6
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Illustration 4.2 Refresh the Fieldbus List

1. Start MCT 10 Set-up Software.

2. Select Network.

3. Right-click Network and select Add/Remove/
Configure Buses.

4. Add, remove, or configure the properties for
connected busses.

5. Scan the network for active frequency converters
to make MCT 10 Set-up Software indicate
available frequency converters on the non-plug-
and-play fieldbusses.

Set-up of Communication VLT® Motion Control Tools MCT 10 Set-up Software
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Illustration 4.3 Fieldbus Configuration

4.3 Automatic Scan

Only the USB fieldbus is scanned automatically when a
frequency converter is connected to the PC. For non-plug-
and-play fieldbusses, perform a manual scan for active
frequency converters.

4.3.1 Scan Range Configuration

Enter the preferred scan settings by right-clicking
SerialCom and then selecting Configure Driver.

Adding a standard bus RS485 or PROFIBUS to the network
tree, the scan range is configured to scan the entire
address range. The Ethernet-TSC bus is added using the
current IP address settings.

The fieldbus scan range can be configured in more ways:
• Right-click the Fieldbus icon in the network tree

and select Configure Bus.

• Mark the Fieldbus icon in the network tree and
select Configure under Communication in the
main menu bar.

• Open the Fieldbus Configuration dialog, right-click
on the Network icon and select Add/Remove/
Configure Buses.

• Open from the Windows control panel.

e3
0b

t4
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2

Scan network icon

Illustration 4.4 Scan Network Icon

4.3.2 Scan Network

Scan a fieldbus in 3 ways:
• Right-click on the Fieldbus icon in the network

tree and select Scan Bus for active frequency
converters.

• Mark the Fieldbus icon in the network tree and
select Scan/Refresh under Communication in the
main menu bar.

• Mark the Fieldbus icon in the network tree and
select the Scan icon on the toolbar.

The Scanning for Drives window pops up and indicates the
progress of the scan:

e3
0b
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Illustration 4.5 Progress of Network Scanning

NOTICE
Using the VLT® HVAC Drive FC 102, VLT® AQUA Drive FC
202, and VLT® AutomationDrive FC 302: FC Drive MC
Protocol (parameter 8-30 Protocol [1] FC MC) is required
for correct functionality. The parameter is only available
from the LCP.

4.4 Set up the Frequency Converter with
RS485 Data Communication

All frequency converters can be configured to 300, 1200,
4800, 9600 (default), 19200, 38400, 57600, or 115200 baud.
The serial configuration is always configured with:

• 8 data bits.

• 1 stop bit.

• Even parity.

4.4.1 Fieldbus Configuration

When using an RS485 converter as the Advantech ADAM
converter, MCT 10 Set-up Software indicates online
frequency converters available on the fieldbus after
scanning the bus.

Set-up of Communication Operating Guide
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1. Open the Serial fieldbus configuration dialog box
or right-click the appropriate fieldbus.

e3
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Illustration 4.6 Serial Fieldbus Configuration

2. Set the COM port number. When using USB to
RS485 converters, the actual COM port number
can be identified from the device manager part
of the Windows control panel.

3. Set the baud rate, parity, and the number of stop
bits (must match the settings in the frequency
converter).

4. Set the fieldbus scanning range to the available
addresses to limit the time scanning for active
frequency converters.

5. Press OK to activate settings or select to restore
default settings.

NOTICE
Protocol and advanced settings are for performance
optimization and should normally not be changed.

4.4.2 USB Data Communication

e3
0b
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Illustration 4.7 Network Bus List

When the USB cable is disconnected, the frequency
converter connected via the USB port is removed from the
network bus list.

NOTICE
A USB bus has no address-setting capacity and no bus
name to configure. If connecting more than 1 frequency
converter through USB, the bus name is automatically
incremented in the MCT 10 Set-up Software network bus
list.
Connecting more than 1 frequency converter through a
USB cable often causes computers installed with
Windows XP to throw an exception and crash. Therefore,
it is advised only to connect 1 frequency converter via
USB to the PC.

4.5 Set-up of Soft Starter

Setting up connectivity to the VLT® Soft Starter MCD 500
requires that the USB communication module is mounted
on the soft starter. Communication from a PC can be
established using a standard A – B male-to-male USB cable
connected to the USB communication module. If the PC is
equipped with more than 1 USB port or a USB HUB,
several soft starters can be connected.

4.5.1 Serial Configuration

All soft starters can be configured to 300, 1200, 4800, 9600
(default), 19200, 38400, 57600, or 115200 baud. The serial
configuration is always configured with:

• 8 data bits.

• 1 stop bit.

• No parity.

e3
0b
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Illustration 4.8 Serial Configuration of Soft Starters

1. Add and configure the bus from the Fieldbus
Configuration dialog. If the bus is already added
to the network, it can be reconfigured by right-
clicking on the appropriate soft starter fieldbus.

2. Set the COM port number. The actual COM port
number can be identified from the device
manager part of the Windows control panel.

3. Set the baud rate, parity, and the number of stop
bits (must match the settings in the soft starter).

Set-up of Communication VLT® Motion Control Tools MCT 10 Set-up Software
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4. Reset to default restores the general settings and
fieldbus scanning to factory configuration values.

4.5.2 Hilscher NetIdent Protocol

Use the tool for searching for devices and for identifying
and changing IP addresses. The tool also has a filtering
function.

To search for soft starters and configure IP addresses:
1. Click the Tools menu.

2. Select Soft Starter Discover and Configuration Tool.

e3
0b
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0

Illustration 4.9 Selecting the Hilscher NetIdent Tool

3. Select the soft starter for which the IP address
should be configured.

4. Click Configure.

4.6 PROFIBUS DP-V1 Communication

Setting up PROFIBUS DP-V1 communication requires a
VLT® PROFIBUS DP-V1 MCA 101 option module. Communi-
cation from a PC using PROFIBUS DP-V1 can be established
using a PROFIBUS PCMCIA card or a card installed in the
PC. The PROFIBUS cable from the frequency converter is
connected to the 9-pin sub D socket connector on the
card.

- V - V

- V - V
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Illustration 4.10 PROFIBUS DP-V1 Communication

Consult Siemens www.siemens.com for latest supported
cards for PCs.

NOTICE
Connectivity via PROFIBUS DP-V1 to a VLT®

AutomationDrive FC 302 utilizing the VLT® PROFIBUS
Converter MCA 114 with option firmware version 2.03 is
not possible from MCT 10 Set-up Software. Use the
fieldbus or USB bus instead.

4.6.1 PROFIBUS DP-V1 Configuration

When using a PROFIBUS interface card with the associated
driver installed, MCT 10 Set-up Software indicates online
frequency converters available on the specific PROFIBUS
after scanning the bus for active frequency converters.

1. Configure the bus from the fieldbus configuration
dialog or by right-clicking the appropriate
PROFIBUS bus.

2. Set the board number.

3. Set the fieldbus scanning range to the available
addresses only to limit the time used for scanning
active frequency converters.

4. Press OK to activate or reset to restore factory
default settings.
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Illustration 4.11 PROFIBUS Fieldbus Configuration

4.6.2 DP-V1 Connection and PG/PC
Interface

The MCT 10 Set-up Software PROFIBUS DP-V1 fieldbus
plug-in utilizes the Siemens SoftNet driver available from
Step7, or alternatively Simatic NET, to establish connectivity
via the supported master class 2 cards such as CP5511 or
CP5512.

NOTICE
STEP7 Lite version does not support the SoftNet driver.

The following procedure explains how to set up the PG/PC
Interface from default configuration to open the PROFIBUS
connection from MCT 10 Set-up Software.

It is a precondition that cabling and terminations are in
accordance with wiring and cabling requirements for
PROFIBUS.
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Illustration 4.12 Set PG/PC Interface

1. Open the PG/PC interface.

2. Configure Access Point of the Application to
CP_L2_1 pointing to the master class 2 card used.

3. Set Interface Parameter Assignment Used
corresponding to the master class 2 card used.

4. Select Properties to configure the station- and
network parameters.

4a Station parameters: Set PG/PC is the only
master on the bus to Active, if no PLC is
active on the bus. Use the Diagnostics
described later to select a valid
PROFIBUS address.

4b Network parameters: Set the
Transmission rate to the same baud rate
as the PLC, if it is active.

5. Use DP as Profile and press OK to close the
Properties dialog.

6. Select Diagnostics in the Set PG/PC Interface to
verify network- and bus communication.
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Illustration 4.13 Properties Dialog
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Illustration 4.14 Simatic Network Diagnostics Dialog

7. Select Test to verify the access path and network
configuration. If a sharing violation is detected,
the test results in an error message. When the
test result is successful, select Read to identify the
active PROFIBUS nodes available on the network.
Make sure that the address defined for the PG/PC
interface does not conflict with an active node.

8. Close the PG/PC interface and start MCT 10 Set-
up Software.

9. Right-click a PROFIBUS and select Scan for active
frequency converters. MCT 10 Set-up Software
identifies the same node IDs, except PLCs.

4.6.3 PROFIBUS Multitelegrams

With the Parameters allowed per telegram drop-down list, it
is possible to configure the number of requests to be
associated within a multitelegram. The standard allows up
to 40 telegrams to be associated.

The following options are available:
• Maximum speed (default configuration). Handles

the association automatically and adapts the
number of telegrams for each frequency
converter according to the series. Can be used in
PROFIBUS networks containing both old and new
Danfoss VLT® frequency converters.

• Conservative. Always associates 10 telegrams
within a multitelegram. This option is useful when
communicating only with old products such as
the VLT® Decentral Drives FCD 300, VLT®

DriveMotor FCM 300, series derived from VLT®

HVAC Drive FC 102, VLT® AQUA Drive FC 202, and
VLT® AutomationDrive FC 302.

• Single request. Only 1 request per telegram.

4.7 Ethernet-TSC Data Communication

To set up an Ethernet-TSC (transparent socket channel)
communication, the VLT® EtherNet/IP MCA 121 option
module is required within the frequency converter.
Communication from a PC can be established using a
standard Ethernet cable connected to the frequency
converter.
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4.7.1 Ethernet-TSC Configuration

An Ethernet-TSC bus is scanned using DDP (drive discovery
protocol). The protocol does not require an IP port number
and IP scan range. It identifies frequency converters based
on the MAC address.

NOTICE
When scanning through different subnets or remotely via a VPN tunnel, it is advised not to utilize the ADDP protocol
but to use an IP range, see Illustration 4.15.

Click Refresh to generate a list of all active frequency converters in the Ethernet. The list is shown in the Ethernet Fieldbus
Settings dialog when the scan is completed.
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Illustration 4.15 ADDP Configuration

Frequency converter types without any IP configuration use their Auto IP Class B address, which is 169.254.yy. xx, with yy.xx
corresponding to the last 2 segments in the MAC address. Several uncommissioned frequency converters without any IP
configuration can be scanned on the same network.
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Select a device from the Discovered Drives list to:
• Get more information about the device.

• Assign a static IP address, a subnet mask, or default value to the frequency converter.

• Set up DHCP (dynamic host configuration protocol) look-up.

e3
0b

t8
57

.1
1

Illustration 4.16 TSC Configure
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4.7.1.1 Scan with IP Range

When scanning using an IP range, the Ethernet telegrams are transmitted as traditional TCP/IP packages routed out in a
router, switch, or manage switch without requiring any changes. The disadvantage is an increased scanning time, and
frequency converters without IP address configured are not identified.

1. Configure the IP start address, IP end address, and the transparent socket channel port
(parameter 12-89 Transparent Socket Channel Port), which is factory default 4000 in the frequency converter.
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Illustration 4.17 Scan Range

After the scan, all active frequency converters are identified. Use a corresponding offline frequency converter to read or
write to a single frequency converter instead of waiting for MCT 10 Set-up Software to scan and identify all frequency
converters.

1. Open the project file or create the offline frequency converter manually.

2. Configure the connection properties.

3. Right-click the offline frequency converter.

4. Read and write to the frequency converter without scanning the bus.

NOTICE
Identification of frequency converters utilizing the VLT® EtherNet/IP MCA 121 option is possible only from option
firmware version 1.03 or newer. Using options with firmware versions earlier than 1.03, the parameter 12-89 Transparent
Socket Channel Port must be configured to 0 to prevent the option from failing to operate.
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4.7.1.2 Filtering

When using multicast, it is possible to filter a range of IP addresses.

Also, use filtering for boosting scan performance.
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Illustration 4.18 Filtering

4.7.2 Wink Drive

During a commissioning process of a system containing
several frequency converters, it can be time-consuming
physically to locate a frequency converter based on the
MCT 10 Set-up Software project. This is especially the case
if they are not equipped with an LCP.

Through the Ethernet-TSC fieldbus, it is possible from MCT
10 Set-up Software using a wink function to blink with the
MS, NS1, and NS2 LEDs on all Danfoss Ethernet-based
fieldbus options.

1. Right-click a frequency converter from the
Ethernet network.

2. Select Start winking or Stop winking.

On the Ethernet-based fieldbus option, the winking is
recognized with all 3 LEDs blinking orange with 1 Hz
interval. There is no limitation in the number of frequency
converters winking and the duration of winking.
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Illustration 4.19 Start Winking

NOTICE
It can take up to 30 s from starting or stopping the
winking, until the option responds.
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4.7.3 Advanced

Use the Advanced tab:
• To configure Port Number For Range Scan. The default value is 4000.

• To define the TSC Connection Allocation/Sharing.

The frequency converter has limited simultaneous connections, and with this function it is possible to define if the
connections should be released or not. If selecting Release Idling Connections, the MCT 10 Set-up Software releases unused
connections and makes them available to other users in the network after idle timeout.
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Illustration 4.20 The Advanced Tab
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5 Parameter Set-up

This chapter explains how to control a frequency converter using the MCT 10 Set-up Software. After starting the MCT 10
Set-up Software, the main window looks like the example shown in Illustration 5.1.
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Illustration 5.1 MCT 10 Set-up Software Main Window

5.1 User Interface

5.1.1 Display

The MCT 10 Set-up Software has 2 views:
• Left view.

• Right view.

Left view
The left view shows the network view (real, online) and the project view (simulated, offline) of the frequency converter
network.

Use the left view to
• Add or delete folders and elements.

• Store changes into the Project folder.

Store changes made to the real online set-up into the Project folder in the simulated, offline set-up for later use.

For more information on saving data, refer to chapter 6.7 Save Changes to a Hard Disk.

The left view is organized in a tree structure and contents can be expanded or compressed as required. Click +/- to expand/
collapse the folder.
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Right view
The right view, as shown in Illustration 5.2, shows details of the element highlighted in the left view. In the right view, the
elements of the frequency converter network can be programmed.
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Illustration 5.2 Details Shown in the Right View

Toolbar
A toolbar shows icons for the most commonly used
functions. See Illustration 5.3.
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Illustration 5.3 Toolbar

Activate the toolbar under View in the main menu bar,
where the toolbar is tick-marked when it is active. To
deactivate the toolbar, select View⇒Toolbar. Check that the
toolbar is no longer tick-marked.

5.1.2 Network and Project Folders

The Network folder gives access to physical devices
operating in the field. Use Network to configure the
physical frequency converters as with the LCP. Configu-
ration changes made in the Network folder are therefore
saved only in the physical device in the field. The Network
folder contains online data.

The Project folder contains offline data.

NOTICE
Changes made in the Network folder are not saved
automatically to the Project folder.

Network mode - online
The Network folder contains the frequency converters, low
harmonic drives, active filters, and/or soft starters online
connected to the PC. Monitor and make changes in the
parameter settings exactly as if operating on the control
panel.
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Data entered online is stored in the frequency converter,
low harmonic drive, active filter, or soft starter only, not on
the hard disk. For information on saving data to the hard
disk, refer to chapter 6.7 Save Changes to a Hard Disk.

Project mode - offline
The Project folder contains the user-defined network of
frequency converter, low harmonic drive, active filter,
and/or soft starter.

Data entered from offline is stored on the hard disk.

Use the Project folder to:
• Open a project file.

• Insert folders.

• Store project-related files in any format, for
example Word or PDF.

5.1.3 Other Folders

4 folder types are available for organizing a large system
into several smaller systems.

Name Purpose Icon

Folder Organize frequency
converters and/or soft
starters that are part of a
machine or of a system.
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File folder Organize files belonging
to a project. Any file
format can be used.
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Parameter
folder

Store parameter settings
temporarily or for
documentation
purposes. The folder can
contain a single
parameter, subgroup,
parameter group, or the
entire parameter
database.
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Scope
folder

Analyze the behavior of
1 or several parameters
for diagnostic purposes
by visualizing them as a
curve.
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Table 5.1 Available Folder Types

Insert any folder type in an offline project in 1 of 2 ways:
• Right-click the project or an existing folder and

select New Folder/New File Folder, as shown in
Illustration 5.4.

• Alternatively, mark the project or an existing
folder and select New Folder/New File Folder under
Insert, in the main menu bar.
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Illustration 5.4 Inserting a Folder Type

5.2 Frequency Converter Set-up

Insert a frequency converter, an active filter, or a soft
starter in a project folder as follows:

1. Right-click in the offline location.

2. Select the appropriate device type.

2a Alternatively, mark the location in
offline.

2b Select Insert in the main menu bar.

Insert a low harmonic drive in a project folder as follows:
1. Right-click in the offline location.

2. Select New Drive.

2a Alternatively, mark the location in
offline.

2b Select New Drive in the Insert menu.

3. Enter all relevant data in the New Drive dialog
and select Make LHD, as shown in Illustration 5.5.
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Illustration 5.5 Entering Data for a new Frequency Converter

NOTICE
The Make LHD option is only available when power size
and voltage ranges of the frequency converter
correspond to the supported low harmonic drive.

4. Enter all active filter data in the New filter dialog.
Ensure that the fieldbus address used for the
active filter is not used for other components.

The low harmonic drive is visible in the project as a
composition of the frequency converter and the active
filter, as shown in Illustration 5.6.
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Illustration 5.6 Low Harmonic Drive Shown in the Project
Folder

To insert a new folder or file folder, do as follows:
1. Right-click the project.

Alternatively,
1a Select Insert in the menu bar.

1b Select New.

1c Select Drive.

1d Select Folder or File Folder.

Here, the term Drive refers to the type of frequency
converter. Inserting a frequency converter opens the New
Drive window, as shown in Illustration 5.7.
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Illustration 5.7 New Drive Window

This New Drive window consists of 4 main sections:

Name Enter a unique name for the frequency converter.
Any text/number combination is allowed. Also
specify the software version and the voltage in this
section.

Select Drive
Type

Information regarding the frequency converter
series and power size. A PUD file (power unit data
information) is also available. The default file is
always preselected.

Options Various information regarding the installed options.

Connection The fieldbus used between the PC and the
frequency converter associated with the address to
communicate. The specific fieldbus type is available
from the drop-down menu.

Table 5.2 Mandatory Fields in New Drive Window

All sections are mandatory to fill in. The different selections
are available from the drop-down menus.

Once the new frequency converter is added in the Project
folder, the frequency converter data is stored in the offline
Project folder. To view the data, click the frequency
converter icon. See Illustration 5.8.
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Illustration 5.8 View the Frequency Converter Data

To change stored frequency converter data, right-click the
specific frequency converter icon and select Properties.

5.2.1 All Parameters Folders

A new Drive folder contains an All Parameters folder, as
shown in Illustration 5.9. This folder comprises a series of
inner folders with generic names. There is no rename
function for these folders. The generic folders within most
frequency converters consist of the following folders:

• Operation and display

• Load and motor

• References and limits

• Inputs and outputs

• Special functions

• Serial communication

• Technical functions

The generic folders can vary according to the type of
frequency converter selected.
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Illustration 5.9 Subfolders in the All Parameters Folder

The generic folders comprise parameters relevant to the frequency converter type selected. See Illustration 5.10.
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Illustration 5.10 Data Example in a Generic Folder

5.2.2 Array Parameters

Parameters containing array data are shown as a matrix in the right view, where the rows of the matrix are identified as ID.1,
ID.2, and so on. For example, array parameters parameter 9-15 PCD Write Configuration and parameter 9-16 PCD Read Configu-
ration are shown over several entries as 915.1, 915.2, 915.3, and 916.1, 916.2, 916.3, in the right view, see Illustration 5.11.
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Illustration 5.11 Array Parameters
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5.2.3 Sorting

The Danfoss products listed under Network or Project in Illustration 5.12 can be sorted according to:
• Folder name.

• Series.

• Software version.

• Address (communication address).

• Power size.

• Voltage.

Click the sorting bar and select the relevant sorting option.
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Illustration 5.12 Sorting Options
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5.3 Customized Views

Select View in the main menu bar to see the display options. As shown in Illustration 5.13, the following options are
available:

• Show or hide the toolbar.

• Show or hide the status bar.

• Large icons/Small icons view.

• View as list of folders and elements.

• View with details of network and project elements.
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Illustration 5.13 The View Menu

Customize parameter view settings
Apply the selected parameter view settings to subfolders, to an entire project, or to the entire application, that is all MCT 10
Set-up Software folders in network or project mode.

1. Right-click the parameter cell or set-up column.

2. Select Apply Parameter View Settings.
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Illustration 5.14 Applying Parameter View Settings

3. Select the relevant option and click OK.
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5.3.1 Customize Background Color

To customize the background color of the views, go to Options⇒Online Parameter Grid Settings.
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Illustration 5.15 Customizing the Background Color

1. Select Restore Default to restore factory default background color for online environment.

2. Click […] to open a standard true color picker.

3. Select Add to Custom Colors for customizing colors for later usage.

5.3.2 Customize Parameter View

The parameters shown in the right view are presented in a series of columns, containing ID, parameter name, 4 set-ups,
units, and factory set-up.

Each set-up can be hidden by selecting Parameter view⇒Set-up⇒Remove Menu.

NOTICE
Changes made to the removed set-up are still stored inside the MCT 10 Set-up Software and can be shown by selecting
Customize Columns.

Add or remove columns to customize view. See Illustration 5.16.
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Illustration 5.16 Customize Columns Dialog
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The actual view can be applied to the complete project or to the folder only.
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Illustration 5.17 Apply Parameter View Settings

5.3.3 Parameter Filter Options

The parameters in the right view can be filtered according to the settings shown in Table 5.3.

Setting Description

Read only Only read-only parameters are shown.

Read & Write Only read & write parameters are shown.

Changed parameters Only parameters that have been changed in the current session are shown.

All All parameter groups are shown.

Group One or more parameter groups are shown according to selection.

Table 5.3 Available Filter Settings

To select the right-view setting:
1. Right-click any column in right view.

2. Select the appropriate filtering setting or the appropriate filtering group, as shown in Illustration 5.18.
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Illustration 5.18 Filtering Columns

Parameter Set-up Operating Guide

MG10RC02 Danfoss A/S © 12/2017 All rights reserved. 33

5 5



5.3.4 Customize Columns

To rearrange the display of columns in the right view:
1. Right-click any column title.

2. Select Customize Columns, as shown in Illustration 5.19.
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Illustration 5.19 Customize Columns Menu

To change the order of the fields in the display:
1. Highlight a field.

2. Select Move Up, Move Down, or Remove.
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Illustration 5.20 Change Order of Fields

Removed columns are still stored in the memory and can
be retrieved into the right view by highlighting the
relevant field name and selecting Add.

5.4 Parameter Edit

The parameter structures in the MCT 10 Set-up Software and in the frequency converter are the same. Modify the parameter
by double-clicking the relevant parameter entry. If an entry cell is shaded in light gray, it is read-only and cannot be
modified.
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Shaded cells indicate read-only parameters

Illustration 5.21 Editing Parameters

Change parameter set-up by manually entering new values in the cells in the right view.
Alternatively, change the parameter set-up by importing values from an active frequency converter, using the Read From
Drive function.
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If a parameter value is set to an illegal value, an error is shown. Parameters can be edited in 2 different modes:
• Dialog-based.

• Inline.
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Illustration 5.22 Edit Parameter View

Inline edit
In inline edit mode, the available setting options are
shown without any detailed descriptions of the options.
Inline edit is only recommended for the experienced user.

Dialog-based edit
To have details of parameters available while editing, use
dialog-based edit.

Parameter details
• Parameter options.

• Ranges.

• Functions.

Enter dialog-based edit by deselecting Inline edit.

5.5 Comparison of Parameters

Parameter settings can be compared to the parameter
settings in another frequency converter. Comparisons can
be made either to another frequency converter inside the
project or to an online frequency converter. The
comparison function evaluates whether settings inside the
frequency converter have been changed, or checks if 2 or
more frequency converters have the same settings.

1. Activate the function by highlighting the desired
frequency converter and selecting Compare. See
Illustration 5.23.
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Illustration 5.23 Comparison

2. Select the frequency converter for comparison.

This can be an online frequency converter from the
network, or it can be a frequency converter in the offline
folder (Project folder).

The result of a comparison can be stored in an ASCII text
file for documentation or for subsequent import into a
spreadsheet.

It is possible to compare all set-ups, or to compare 1 set-
up to another.
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Illustration 5.24 Comparison Result
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5.6 View Change Log

When configuring a frequency converter, active filter, or
soft starter from the project, it is possible to view the
change log containing the changes made by the user only,
or the changes made including the dependent parameters.

User-defined changes can be read out by right-clicking All
Parameters and selecting Minimal changeset. See
Illustration 5.25.
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Illustration 5.25 Minimal Changeset

Changes made including the dependent parameters can
be read out by right-clicking All Parameters and selecting
Compare parameters with default values. See Illustration 5.26.
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Illustration 5.26 Compare Parameters with Default Values

5.7 Read Drive Operation Status

The frequency converter can be in 2 different operation
conditions: Auto On or Off. This can be monitored via the
LCP or MCT 10 Set-up Software. Use MCT 10 Set-up
Software to monitor the actual operation status by clicking
a frequency converter located in the network. Select
Refresh status to update the status information. Parameters
can only be written to frequency converters in operation
status Off.
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6 Operation

6.1 Reading and Writing Parameters

Parameter settings can be read from or written to an online connected frequency converter.

Most parameters are read/write and can thus be configured. Other parameters are read-only and cannot be configured.
View which parameters are read/write or read-only in the filter function.

Select the values to be read/written and then select the Read From Drive or Write To Drive menu.

The following options are available:
• A single parameter in the right view.

• All parameters in the left view.

• A group of parameters in the left view, for example the Load and motor group.

The read-from-drive and write-to-drive functions apply to the whole selection. See Illustration 6.1.

Select Options in the menu bar to access a range of functions.
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Illustration 6.1 Select Options
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6.1.1 Read From Drive Settings

Select the desired options for reading from an active
frequency converter.

Set-ups
Select to read visible set-ups only, or to read all set-ups.

Drive differences
Specify the acceptable level of compatibility errors, if field
device software and MCT 10 Set-up Software versions are
not identical. Select Allow drive differences to ignore all
compatibility errors.
Select Allow drive version difference to restrict the
acceptable compatibility errors to those occurring in
different software version but same frequency converter
series. Select Do not allow drive differences not to accept
differences between online devices and offline devices.

Save as default settings
Activate the Read From Drive-settings for all reads from the
frequency converter.

e3
0b

t8
54

.1
1

Illustration 6.2 Read from Drive Settings

6.1.2 Write to Drive Settings

Select the desired options for writing to an active
frequency converter, which then becomes applicable for all
writing to frequency converters. See Illustration 6.3.
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Illustration 6.3 Write to Drive Settings

Write option
By default, Write All Parameters is selected. This means that
all read and write parameters are written to online
frequency converters.

If selecting Write Changed Parameters, only the subset of
parameters different from default are written. This selection
improves performance.

6.1.3 Communication Fault Tolerance

Set an acceptable number of communication faults before
disconnecting. The default number of failures is 1000.
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Illustration 6.4 Fault Tolerance
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6.2 Connection Properties

To read or write between online and offline frequency
converters, the connection properties must be configured
in the offline project. If the fieldbus does not refer to an
available frequency converter in the network tree, MCT 10
Set-up Software is not able to identify the online
frequency converter.

Reconfigure the fieldbus by right-clicking the offline
project and select Properties⇒Connection.

Configure the fieldbusses added to the network tree in the
Fieldbus drop-down list.

6.3 Read From Drive

Values can be read from an active frequency converter by right-clicking on the desired selection and then selecting Read
From Drive. See the example in Illustration 6.5.
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Illustration 6.5 Read from Drive

Once Read From Drive is selected, the software accesses the online device and shows the Drives Check window. This window
contains a list of frequency converters with detected compatibility issues. See Illustration 6.6.
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Illustration 6.6 Drives Check

Select Details to view details on the different properties between project device (based on database information) and online
device, that is connected frequency converter, as in Illustration 6.7:
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Illustration 6.7 Details
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The color codes indicate the level of compatibility between the project drive and the connected drive for each property.

To continue the reading process, define an action in the Drives check dialog. The default action is Continue. Other available
selections are:

• Skip the drive.

• None.

• Update project and continue.

The same action can be applied to all devices at a time instead of one by one.

If selecting Skip the drive, MCT 10 Set-up Software does not read that particular device, but continues reading the other
devices.

Continue resumes reading. Acknowledge and accept any differences found.

Update project and continue activates the read-from-drive process, and it deletes the data in the project drive and replaces it
with data from the connected frequency converter.

NOTICE
The Update drive from connected selection causes all information stored in the project drive to be deleted and replaced.
To retain the information entered into the project drive, select Continue.

Once the read-from-drive process is completed, the display shows details of both the Connected Drive Information and the
Database Information. See Illustration 6.8.
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Illustration 6.8 Read-from-drive Process Completed
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6.4 Write to Drive

Write values to an active frequency converter by right-clicking a parameter column title in the right view and then selecting
Write to drive.
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Illustration 6.9 Write to Drive

Alternatively, access Read From Drive and Write to drive by
selecting Communication in the main menu.

6.5 Poll

When in network mode, MCT 10 Set-up Software automat-
ically polls the parameters in the right view to
continuously update their status to reflect live operation.

To stop polling, for example to freeze and analyze a
particular moment:

• Select Stop polling under Communication in the
main menu bar

or
• Select Stop polling from the toolbar, as shown in

Illustration 6.10.
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Stop polling icon

Illustration 6.10 Stop Polling Icon

Resume polling in 2 ways:
• Select Resume polling under Communication in

the main menu bar

or
• Select Resume polling from the toolbar, as shown

in Illustration 6.11.
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Illustration 6.11 Resume Polling Icon

6.5.1 Smart Polling (Intelligent Scan
Frequency)

While the MCT 10 Set-up Software is polling the parameter
grid, the LCP becomes slow. To improve LCP usability,
configure MCT 10 to enable smart polling. Enabling smart
polling slows down the polling when the LCP is connected.

To enable smart polling:
1. Click the Options menu.

2. Select Online Parameter Grid Settings.
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Illustration 6.12 Selecting Online Parameter Grid Settings
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3. Tick the checkbox Enable Smart Polling (slow down
the polling when LCP is connected).
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Illustration 6.13 Ticking the Checkbox

6.6 Changing the Set-up of a Device in the
Field

To change settings for a field device, open the Network
folder and select the relevant device.

Select Stop on the toolbar to stop polling and change the
settings in the set-up columns in the right view.

NOTICE
The changes are implemented online in the field device,
but are not recorded.

6.7 Save Changes to a Hard Disk

6.7.1 Record Online Changes

To record online changes to a hard disk:
1. Select the relevant device in the Network folder.

Right-click the device, and select Copy.

2. Select the Project folder, right-click, and select
Paste.

3. Select File from the main menu bar, and select
Save As.

4. Save the device file into a directory in the storage
location.

6.7.1.1 Save a Project

Save a project by selecting File⇒Save from the main menu
bar. Alternatively, select the Save icon on the toolbar.

Include drive information

It is not possible to open a project file including a
firmware version not supported by MCT 10 Set-up
Software. Including the frequency converter information in
the project file makes it possible to open in other instal-
lations with MCT 10 Set-up Software without having the
firmware installed. Opening the project file, the frequency
converter information is updated similarly to:

• Selecting Update Drive Support under Tools in the
main menu bar.

• Downloading the frequency converter
information from an online frequency converter.

The frequency converter information is saved in the project
file. To exclude the frequency converter information in the
project file:

1. Select Options.

2. Select Project properties.

3. Click to enable Project-related Files. See
Illustration 6.14.
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Illustration 6.14 Save Frequency Converter Information
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6.7.2 Archive/Unarchive

Projects that include links to other documents can store the linked files.
By selecting the Archive function, the MCT 10 Set-up Software generates a file that contains all frequency converters and the
linked files into a *.ssa File. If this file is sent to other computers, the user gets a copy of the linked files on the computer.

6.8 Import of Older Dialog Files

For users working with VLT set-up software dialog, the files generated with these software packages can be imported into
the MCT 10 Set-up Software.
Files from DOS versions and Windows versions can be imported to the MCT 10 Set-up Software. Following a successful
import, the MCT 10 Set-up Software places the imported files in an imported files folder.
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Illustration 6.15 Import Older Dialogs

Due to limitations in some of the former PC tools, some functionalities cannot be imported, for example functions such as
showing changed values only.

6.9 Printing

There are 2 options for printing from MCT 10 Set-up
Software:

• Print project.

• Print selected folders.

Both options are located under File in the main menu bar.
Alternatively, select Print project by right-clicking the Project
icon. Select Print selected folders by right-clicking the icon
for a folder within the project.

Select Print project to print parameter settings for an entire
project.
Select Print selected folders to print parameter settings for
part of a project.

A dialog box, as shown in Illustration 6.16, pops up:
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Illustration 6.16 Print Options

Select the desired print language from the drop-down list.
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Changed parameters

Select this option to print all parameters or to print
changed parameters. Select between parameters:

• Changed from default.

• Changed from factory default.

• All parameters.

Options
Specify which set-up to print.

Groups
Select Groups to print selected parameter groups only.
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Illustration 6.17 Print Changed Parameters

1. Select the parameter groups to print.

2. Select Groups to return to the original
unexpanded print dialog box.

3. Click OK to print.
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6.10 Update Database Information

If the MCT 10 Set-up Software database information is outdated, updates are available either by download from the Internet
or, when this is not possible, by reading from the frequency converter itself.

When the MCT 10 Set-up Software database for a frequency converter is outdated, the frequency converter icon is shown
with a red line through it and the Database information fields show the message Not supported.
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Illustration 6.18 Outdated Software Database

Update the database either by right-clicking the frequency converter icon and selecting Download drive info, or by clicking
Download drive info. See Illustration 6.19.
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Illustration 6.19 Database Update

To start reading from the frequency converter, select Yes.

When reading from the frequency converter is complete, the frequency converter icon no longer has a red line through it,
and the Database information shows settings identical to the Connected drive Information.

Also, the parameter settings are shown in capital letters.
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6.11 Update Drives Firmware Support in MCT 10 Set-up Software

MCT 10 Set-up Software can be updated regardless of the firmware version of the frequency converter.

Download upgrades from the Danfoss website www.vlt-software.com and store them on a local disk drive.
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Illustration 6.20 Update MCT 10 Set-up Software

NOTICE
The update files can be installed without administrator rights in Microsoft operating systems.

6.12 Software Compatibility

MCT 10 Set-up Software project files can open legacy version project files. Table 6.1 shows an example.

Software versions of MCT 10
Set-up Software and frequency
converter in existing project
file

Software versions
of MCT 10 Set-up
Software

Compatible
✓/✗

2.00 and 2.01 2.02 ✓
2.02 and 2.51 2.00 ✗

Table 6.1 Opening Legacy Versions

When MCT 10 Set-up Software has been updated, project-files saved with newer version firmware can be opened and used.
This scenario is shown in Illustration 6.21.
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Illustration 6.21 Use Updated MCT 10 Set-up Software

To establish connectivity to a frequency converter with
firmware version 1.10, it is required to modify the MCT 10
Set-up Software drive database mapping to firmware
version 1.05 as reference.

• Start the MS Explorer and open the path C:
\Program Files\Common Files\Danfoss Drives
\SharedSource\.

• Open the text file ss_version_mapping.txt in
Notepad by right-clicking the file and selecting
Edit.

• Change
"Series="FC-202",AOC="01.10",Database="01.10" to
Series="FC-202",AOC="01.10",Database="01.03".

• Save and close the file.

To find out if the MCT 10 Set-up Software has been
updated, check the information in the About box. This box
shows the actual MCT 10 Set-up Software version. See
Illustration 6.22.

NOTICE
System information can be copied directly to the
Windows clipboard.
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Illustration 6.22 Copy System Information

Operation Operating Guide

MG10RC02 Danfoss A/S © 12/2017 All rights reserved. 51

6 6



6.13 Conversion Wizard

6.13.1 Match

It is required that database versions, power size, voltage
range, and option configuration of the source match the
destination frequency converter. Differences can be
converted using 1 of the conversion wizards available in
MCT 10 Set-up Software:

• VLT to FC series conversion.

• FC to FC series conversion.

NOTICE
If the parameter database of a source frequency
converter is different from the database on the
destination frequency converter, it cannot be written
without errors signaled during write to drive.

6.13.2 VLT to FC Series Converter Function

It is possible to convert for example a VLT 5000 frequency
converter to a VLT® AutomationDrive FC 302 with the
conversion matrix in the MCT 10 Set-up Software.
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Illustration 6.23 Conversion

Conversion of multiple frequency converters

1. Select the Tools menu and activate Drive
Conversion Wizard.

2. In the subsequent dialogs, select the frequency
converters for conversion.

3. When converted, a new FC 302 frequency
converter is created in the Project folder.
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Illustration 6.24 Conversion of Multiple Frequency Converters

6.13.2.1 Import Drive from Excel

Ise this function to create an FC30x frequency converter
project based on an Excel sheet. For example, import of
VLT 3000 settings from an Excel sheet into a new FC 302.

An example file is attached in MCT 10 Set-up Software
(vlt3000conversion.xls). This example file can be edited and
used for converting from VLT 3000 to FC 302.

NOTICE
Detailed knowledge of Microsoft Excel formula editing is
required.
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6.13.3 FC to FC Series Conversion

The converter tool can convert projects within the same frequency converter series, regardless of software versions, power
size, voltage range, and option configuration. It covers VLT® HVAC Drive FC 102, VLT® AQUA Drive FC 202, VLT®

AutomationDrive FC 302, VLT® Lift Drive LD 302, and all OEM versions based on the FC xxx series. Differences can be
matched by using the Conversion tables manager.

A conversion table enables conversion from:
• Online to online drive.

• Online to offline drive.

• Offline to online drive.

• Offline to offline drive.

2 user profiles are available:
• Administrator – qualifies and manages the conversion tables through access to the Conversion tables manager.

From the Conversion tables manager, new conversion tables can be created and deployed to other MCT 10 Set-up
Software installations.

• User – writes projects to the destination using the conversion tables transparently. The user cannot access the
Conversion tables manager. Conversion tables can be imported to the database.

MCT 10 Set-up Software is installed with user rights. Enabling the Conversion tables manager is done from the checkbox in
the Converter tool settings dialog.
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Illustration 6.25 Enabling Conversion Table Manager

The conversion tables are stored locally on the hard disk. Using the database non-distributed, the path to the network
location can be reconfigured from the Converter tool settings dialog.
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6.13.4 Conversion Tables Manager

Access the Conversion tables manager, as shown in
Illustration 6.26, through the MCT 10 Set-up Software tools
menu.
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Illustration 6.26 Conversion Tables Manager

The dialog is divided into the following sections:
• A conversion table containing the list of

conversion tables in the database.

• A preview pane.

Conversion tables can be created or imported, edited,
exported, or deleted.

Exporting tables
Distribute to other MCT 10 Set-up Software installations by
exporting the relevant tables to a *.cvt file. The preview
pane lists the conversion table source and destination
frequency converter information.

The conversion can be as follows:
• Drive series based on the FC 102/FC 202/FC 3xx

platform

• Software version (major and minor)

• Power size

• Voltage range

• Option A

• Option B

• Option C0

• Option C1

Create conversion tables
To create a conversion table, open the Conversion tables
manager or right-click the source drive and select Convert
drive.

NOTICE
When using the right-click option, it is only possible to
configure the information of the destination frequency
converter. Furthermore, parameter group 19-** User-
defined Parameters is not converted. These settings are
configured when writing from source to destination.
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Illustration 6.27 Drive Conversion
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Editing tables
In the Drive conversion view, enter the information for
source and destination frequency converters. Click OK to
open the Conversion table editor listing the parameter
database differences.

Use the Conversion table editor to create or load a
conversion table. Ensure that the conversion table matches
the frequency converter series, software version, power
size, voltage range, and option configuration. The MCT 10
Set-up Software is not able to find and load incompatible
conversion tables. After loading or creating the conversion
table, it is possible to re-edit the table or to convert the
source frequency converter and store the converted
frequency converter in an offline folder.

Formulas
The parameter database is listed and sorted according to
the parameter ID. To simplify the conversion process, filter
the database to list alerts or applied changes only.

Color
code

Description

Red Difference between source database and frequency
converter. A formula is required before changes can be
applied to the frequency converter.

Blue Difference between source database and frequency
converter. The formula is ignored and changes can be
applied to the frequency converter.

Table 6.2 Alert Color Coding
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NOTICE
If a formula is applied to all alerts, the source parameter
database can be converted to the destination parameter
database without any further configuration.
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Illustration 6.28 Conversion Table

Double-click an alert to open the Formula Editor dialog and specify the destination parameter mapping. The following
configurations are possible:

• Destination parameter is set to default value (factory default value. Default setting for red alerts).

• Destination parameter = source parameter ID.

• Destination parameter = source parameter multiplied by a user-defined numeric value.

• Destination parameter = destination option list or numerical value.

• Ignore this parameter. Default setting for blue alerts.
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Each formula applied can be associated with a comment containing a user-defined text. The comment is optional to each
alert.
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Illustration 6.29 Formula Editor

When a formula is applied to all red alerts, assign a name to save the conversion table in the database.

If differences are detected when writing from source to destination frequency converter, MCT 10 Set-up Software uses the
following as search criteria:

• The frequency converter series.

• Major software version.

• Power size.

• Voltage range.

• Option configuration.

With the proper conversion table in the database, any frequency converter can be written transparently to a destination
even if the minor software version does not match. If several conversion tables are found matching the criteria, MCT 10 Set-
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up Software uses the minor software version to find the closest match. Only 1 frequency converter can be written
transparently to the destination.

If parameter group 19-** User-defined Parameters is available, the settings are written transparently to the destination
frequency converter.

6.13.4.1 Convert Offline to Offline/Online to Online

Writing between 2 offline or 2 online frequency converters is done as follows:
1. Mark the appropriate number of set-ups from All Parameters.

2. Right-click and select Copy.

3. Paste the parameters in the destination frequency converter folder.
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Illustration 6.30 Offline Online Conversion

MCT 10 Set-up Software recognizes any difference and automatically applies a matching conversion table, if available.
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6.13.4.2 Convert Online to Offline/Offline to Online

NOTICE
Before converting, ensure that offline and online frequency converter connection properties correspond.

Write from online to an offline frequency converter by right-clicking the offline frequency converter and selecting Read from
Drive as shown in Illustration 6.31. MCT 10 Set-up Software recognizes any difference and automatically applies a matching
conversion table.

e3
0b

t7
29

.1
1

Illustration 6.31 Offline Online Conversion

NOTICE
Make sure that the offline frequency converter connection properties correspond with the online frequency converter.
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7 Diagnostics

7.1 Alarm, Warning, and Fault Log Readout

Features from version 2.0, MCT 10 Set-up Software
support:

• Reading out alarms, warnings, and fault logs of
the online frequency converters.

• Quick location of alarms and warnings in the
connected drive system.

• Investigation of the fault log for previous trips.

• Gathering and storing events in the project file
for later evaluation.

• Sending the project file to a remote specialist for
further investigation.

7.2 Localization of Alarms and Warnings

After a complete scanning of a drive network, the MCT 10
Set-up Software indicates if the connected frequency
converters have active warnings or alarms. An exclamation
mark in front of the frequency converter icon indicates a
warning or an alarm.
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Illustration 7.1 Frequency Converter with Active Alarm or
Warning

Expand the frequency converter and click the alarm/
warning icon.

Name Icon

Active
alarms/
warnings e3
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No active
alarms/
warning e3
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Illustration 7.2 Fault Log View for Control Cards Marked MKI
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Illustration 7.3 Fault Log View for Control Cards Marked MKII

Diagnostics VLT® Motion Control Tools MCT 10 Set-up Software

60 Danfoss A/S © 12/2017 All rights reserved. MG10RC02

77



For a more detailed description of the code, refer to the operating guide for the particular frequency converter.
If the frequency converter trips, it stores the cause for the trip in a fault log buffer. The log consists of 3 values:

• Code

• Value

• Time

When MCT 10 Set-up Software reads the fault log, it shows the time and date when the log was read.

NOTICE
The actual time when a fault occurs is not indicated.

7.3 Storing Alarms/Warnings in Project Files

Alarms/warnings and the fault loggings are stored into the Project File. The MCT 10 Set-up Software automatically reads
alarms, warnings, and fault loggings at every read from/write to the frequency converter.

7.4 Handling the Alarms and Warnings
Loggings

MCT 10 Set-up Software allows more than 200 alarms and warnings for each frequency converter in the project. The
loggings can be individually cleared. This is done by entering the loggings to clear and then right-clicking. Clearing the log
only clears the PC log while the information in the frequency converter is unaffected by this handling.

NOTICE
There are redundant alarm entries in log.

The MCT 10 Set-up Software stores active alarms and warnings in the project file at each read/write command. No alarm is
lost, but an alarm can have multiple entries in the log.
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Illustration 7.4 Loggings
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7.5 Scope Function

The scope function supports monitoring and diagnosing of
parameters. The function polls parameter data and
dynamically shows the polled data as a curve graph.

The scope function provides 2 different channel types to
sample parameters:

• PC polling channel – Channel selected when the
PC SW requests the parameters from the
frequency converter. The channel does not have
any time limitation, the buffer size is user-config-
urable and corresponds to the number of
samples. Fast sampling with accurate sampling
rate cannot be obtained because the Windows
operating system does not support real-time
extension.

• Drive real-time channel – Only available in the FC
102, FC 202, and FC 300 series - uses an internal
16 kByte buffer located in the frequency
converter. Recommended for continuously
monitored applications requiring high and precise
sampling rates. It is required to set up a trigger
event for the frequency converter to start filling
up the buffer with samples.

7.5.1 Activating the Scope - MCT 10 Set-up
Software

Insert a new scope from the Insert menu or by right-
clicking the Project folder, Drive folder, Regular folder, or
Drive.
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Illustration 7.5 New Scope

Rename the scope folder via the Edit menu or by right-
clicking the icon and select Rename.

The first time that the Scope folder is selected, the Add
channel dialog pops up. From this dialog, select the
frequency converter to monitor. Then, depending on the
frequency converter series, select the type of channel to
collect samples from.
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Illustration 7.6 Add Channel

Adding text notes
Insert additional text for later usage to each scope folder
such as the type of frequency converter monitored and
diagnostic help text. Text notes are added by right-clicking
the Scope folder and selecting New⇒Text note. The default
text can be changed by right-clicking the text note and
selecting Rename. Several text notes can be added to the
same scope folder, as shown in Illustration 7.7.
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Illustration 7.7 Text Notes
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7.5.2 Configure the PC Polling Channel

PC polling channel is default enabled when a frequency
converter is selected within the Network folder or Project
folder. All parameters available in the list are visible by ID
and name and are automatically updated according to the
product.
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Illustration 7.8 Parameter ID and Name

1. Select a parameter in the parameter list and click
Next to update the Add channel dialog.

2. Configure A/div (value/division).

NOTICE
MCT 10 Set-up Software stores the values even if they
are not shown within the visible area of the curve.
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Illustration 7.9 Storing Values

3. Define the position number (vertical zero line on
the Y axis). If there are several signals on top of
each other, it is useful to have them plotted
apart.

4. Set color and tick Marker to differentiate the
different curves in a black and white printout.
Each curve gets a marker as box, triangle, cross,
and so on.

5. Click OK to generate the curve graph.
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Illustration 7.10 Generate Curve Graph

Right-click the channel box to open the Add channel dialog
and add extra channels.
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Illustration 7.11 Open Add Channel Dialog

7.5.3 PC Polling Channel Properties

More settings can be configured by right-clicking the
Scope window and selecting Properties. It is possible to
specify:

• General parameter sample settings.

• Sample trigger settings.

• Cursor settings.

General parameter sample settings

The General tab holds 4 basic settings for the Scope
Properties:

• Seconds per division (SEC/DIV).

• Time format.

• Buffer size in samples.

• Polling rate in milliseconds.
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Description Format Value range

SEC/DIV Time base on the X-axis 0.0001–
1.000.000.000 s

Time format Year, month, date, hour,
seconds, and milliseconds

–

Buffer size Number of data sets in the
buffer

0–1.000.000

Polling rate Time in milliseconds between 2
samples

–

Illustration 7.12 Basic Scope Settings

NOTICE
For systems with large inertia, a low sampling rate may
be used since the value changes slowly. For systems with
low inertia, a high sampling rate is needed.

NOTICE
Setting Polling rate to As fast as possible means that MCT
10 Set-up Software does not control the actual time
between each sample. This can lead to a high jitter
between 2 samples.

Trigger
The trigger function starts the sampling of values only
when a certain value is reached. This reduces the need for
large buffer sizes. A trigger is also a valuable tool to see if
values cross borders where the frequency converter does
not store any warnings.
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Trigger
functions

Description

Source Source channel.

Level Level where the trigger has to be activated.

Mode Auto starts the trigger automatically when Resume
All is pressed. The trigger line is set to the time
when Resume was pressed. Normal (Norm) activates
the trigger when level and slope settings are
fulfilled.

Slope Sets if the value must rise (source value goes from
low values to high values) or the slope must fall
(source value goes from high values to low values).

Illustration 7.13 Trigger Functions

Cursor

Style defines the functionality of the cursor. The style
contains 5 different possibilities:

• Value XY - Shows the time and value of each
signal at the cursor location.

• Value X – Shows the time alone.

• Value Y – Shows the value alone.

• Delta X - Shows 2 cursors, and the time between
the 2 cursors is calculated.

• Delta Y – Works like Delta X, but this time the
difference between 2 levels is calculated.

Pointer position defines the default position when a cursor
is inserted in Scope.

7.5.4 Reuse of PC Polling Channel Settings

Often the same settings are used when measuring with
the PC polling channel on more than 1 frequency
converter. These settings can be reused either by copying
an existing scope folder or by reusing an existing one.

The scope folder connection properties can be
reconfigured for another frequency converter in the
network by double-clicking an added channel. In the
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Reconfigure Channel dialog, another frequency converter
located on the same or a different fieldbus can be
selected.
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Illustration 7.14 Reconfigure Channel

7.5.5 Configure the Drive Real-time
Channel

Drive real-time channel can be selected if the functionality
is supported in the frequency converter selected in the
network.

1. Select the relevant frequency converter.

1a Drive real-time channel opens the Scope
properties dialog.

2. Configure the channels depending on what the
actual frequency converter supports.
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Illustration 7.15 Select Drive Real-time Channel

All available parameters are listed by parameter name.

3. Configure the sample rate for each channel using
the time format HH:MM:SS:zzz.

4. Configure sampling mode through:

4a The trigger event.

4b Logging mode.

4c Samples before trigger options.
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Illustration 7.16 Configure Sampling Mode
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7.5.6 Using Advanced Triggers

NOTICE
The real-time channel trigger event utilizes the event
available from the smart logic controller.

Example
The following example explains the set-up of a trigger
which triggers the collection of data in the frequency
converter when the motor speed exceeds a certain limit.

Set up a comparator in the smart logic control to get a
trigger signal when the motor speed exceeds a certain
limit:

1. Select the smart logic group.

2. Select a comparator not in use, 1310.0, and set it
up to motor speed.

3. Set Comparator operator 1311.0 to greater than
>.

4. Set Comparator value 1312.0 to the required
value.

5. Set up the trigger event in the Drive real-time
channel properties dialog to comparator 0, and set
the logging mode to log once on trigger.

Press OK to enable the set-up.
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Illustration 7.17 Smart Logic View
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Illustration 7.18 Trigger Event

To start MCT 10 Set-up Software logging, press Start
(resume) poll, which opens the dialog to define the real-
time log style.
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Illustration 7.19 Real-time Log Style
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7.5.7 Drive Real-time Channel Properties

More settings can be configured by right-clicking the
Scope window and selecting Properties.

It is possible to reconfigure all Drive real-time channel
settings and also to configure:

• SEC/DIV and time format.

• Appearance settings.

• Cursor settings.
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Illustration 7.20 Reconfigure Drive Real-time Channel Settings

Besides being able to reconfigure the settings made from
the Drive real-time channel properties dialog, SEC/DIV and
the time format are configurable.

SEC/DIV
The SEC/DIV and Time format functionalities are similar to
the PC polling channel functionality, see
chapter 7.5.2 Configure the PC Polling Channel.

Appearance
Each channel name can be renamed.

The Units/Div, Position, Marker, and Color functionalities
are similar to the PC polling channel functionality.

Cursor
The functionality is similar to the PC polling channel
functionality.

7.5.8 Communication Control

The Scope toolbar has 4 main buttons to control the
communication.

Control Button  Function

Start (data
acquisition)
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2 MCT 10 Set-up Software scope

starts collecting the requested
data from the frequency
converter network.

Stop (data
acquisition)

e
3
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1
.1

2 MCT 10 Set-up Software stops
collecting data and there is no
communication to the frequency
converter network while the
scope part is active on the
screen.

Start (resume) all
tracking
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2 Activates the tracking

mechanism. MCT 10 Set-up
Software starts the readout of
variables to the screen and to
the buffer. Variables are checked
up against the trigger settings. If
the buffer has been partially
filled (use of the Pause All
Tracking function), MCT 10 Set-
up Software continues to fill
data into the buffer.

Pause all tracking

e3
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2

.1
2 Deactivates the tracking. The

buffer remains at its current
state, no new data is shown.
The buffer pointer keeps its
current position.

Table 7.1 Functions of the Control Buttons

7.5.9 Additional Functionality

Select Resume poll to start tracking. To stop tracking, click
Stop poll or Pause all tracking. The tracking continues until
the buffer is filled (default 1000 samples). If the tracking
stops due to a filled buffer, the buffer has to be emptied
before a new track can be activated. Clear the buffer and
reset the scope in 1 step by clicking the icon shown in
Illustration 7.21.
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Illustration 7.21 Clear all Buffer for the Channel

Alternatively, the buffer can be cleared individually.
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Illustration 7.22 Individually Clear the Buffer

Name Description Icon

Reset scope Clears all buffers for the
channel at once. This is more
convenient if many channels
are activated at the same
time, or if a new channel is
added to an existing track.
Before new values can be
added to a track, all channel
buffers must be emptied,
since MCT 10 Set-up
Software requires that all
buffers have the same
amount of data.
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Export to
Excel

Enables storing scope data
in a file which Microsoft
Excel can open. A Save file
dialog appears, making it
possible to store the file in
an appropriate location.
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Open
storage

Enables storing scope data
in a file on the hard disk.
Save to the hard disk to
avoid the limitation of 1
million points in the project
file.
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Open scope
history
viewer

Open scope data saved on
the hard disk.
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Table 7.2 Main Buttons

7.5.10 Scope Storage

Enable scope storage or persistent data storage in Scope
properties. In Scope properties, it is also possible to change
and select where data should be saved.

e3
0b

t8
60

.1
1

Illustration 7.23 Scope Properties

If polling data in scope when scope storage is selected,
data is saved in both the project file and on the hard disk.
However, the project file is limited to 1 million points.
When the limit is exceeded, MCT 10 Set-up Software
replaces the oldest point with the latest point.
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8 Smart Logic Controller Plug-in

From version 2.13, MCT 10 Set-up Software supports the
smart logic controller plug-in. This feature enables quick
set-up of logical sequence programs.

The smart logic controller monitors a predetermined event.
When the specified event occurs, it performs a
predetermined act and starts monitoring the next
predetermined event. The smart logic controller continues
like this in up to 20 different steps until it returns to step 1
– monitoring the 1st specified event.

The logic controller can monitor any parameter that can be
characterized as true or false. This includes digital
commands and logic expressions, which allow sensor
outputs to determine the operation. Temperature, pressure,
flow, time, load, frequency, voltage, and other parameters
combined with the operators >, <, =, AND, and OR form
logic expressions that control the frequency converter
logically in any application.

Refer to the relevant design guide for a full overview of the
smart logic controller features.
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9 Time-based Actions and Preventive Maintenance Plug-ins

For the VLT® HVAC Drive FC 102, VLT® AQUA Drive FC 202,
and VLT® AutomationDrive FC 301/FC 302, the MCT 10 Set-
up Software provides the following plug-ins:

• Clock features.

• Preventive maintenance.

• Time-based actions.

NOTICE
Consult the relevant design guide for detailed
information about the frequency converters.

9.1 Clock Functions

MCT 10 Set-up Software enables set-up of the clock
features.

The clock features are grouped in 2 sublevels:
• Date and time.

• Working days.

9.1.1 Date and Time

In the Date and time dialog, the following groups of
settings are available:

• Display format.

• Set date and time.

• Daylight saving time.

• Enable clock fault.

Display format in LCP
Select how date and time are presented in the LCP on the
frequency converter. In MCT 10 Set-up Software
parameters, date and time format depends on PC regional
options (date and time format).

Set date and time
Change the date and time in the frequency converter from
the PC. Normally, it should be set to use the connected
PC’s date and time. When the connected PC’s time is in
another time zone, it is beneficial to set the date and time
manually.
Date and time are changed in the MCT 10 Set-up Software
project file or in the frequency converter only when the
Change checkbox is ticked.

Daylight saving time
Set the date and time for daylight saving.

Daylight saving time begins for most of the United States
at 2:00 a.m. on the first Sunday of April. Time reverts to
standard time at 2:00 a.m. on the last Sunday of October.
In the U.S., each time zone switches at a different time. In
the European Union, summer time begins and ends at 1:00
a.m. Universal Time (Greenwich Mean Time). It begins the
last Sunday in March and ends the last Sunday in October.
In the EU, all time zones change at the same moment.

Enable clock fault
If the clock is not set up, the frequency converter shows a
specific warning. Enable or disable the clock fault function.
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9.1.2 Working Days

Define the working days for time-based actions as follows:
1. Select First day of the week (Monday or Sunday).

2. Select working days and non-working days.

3. Set additional working days (maximum 5).

4. Set additional non-working days (maximum 15).
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Illustration 9.1 Define Working Days

NOTICE
Additional working days and non-working days include the year and must be updated every year.
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9.2 Preventive Maintenance

The preventive maintenance feature supports the planning of periodic maintenance of both the frequency converter and
other technical equipment. If the defined date and time of preventive maintenance is passed, the item is marked red.
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Illustration 9.2 Preventive Maintenance

1. Double-click the cells in the right view to specify application item, action, and interval.

2. Reset Maintenance Word (parameter 23-15 Reset Maintenance Word) and write to drive.

NOTICE
The clock parameters (parameters in the Clock functions folder) must be programmed for preventive maintenance to
function correctly.
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9.3 Timed Actions

The time-based actions function enables automation of real-time controlled events.
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Illustration 9.3 Time-based Actions

1. Select Timed Actions in the product folder.

2. Double-click the cells in the right view to specify:

• Action.

• Time.

• Recurrence.

NOTICE
The clock parameters (parameters in the Clock functions folder) must be correctly programmed for timed actions to
function correctly.

Actions, which can be programmed, are the same as known from the SLC (smart logic controller), see chapter 8 Smart Logic
Controller Plug-in.
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10 Motor Plug-in

The Motor plug-in is an offline plug-in showing relevant
parameters for commissioning of the motor. Select the
plug-in from the structure.
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Illustration 10.1 Selecting the Motor Plug-in

The parameters shown depend on the setting in
parameter 1-10 Motor Construction.
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Illustration 10.2 Select Motor Type

Asynchronous motors
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Illustration 10.3 Example of Settings for an Asynchronous Motor
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PM Non-salient SPM
For PM motors, calculation buttons are available to help getting the correct values.
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Illustration 10.4 Example of Settings for a Non-salient SPM Motor

Example
Setting parameter 1-25 Motor Nominal Speed.

1. Enter the frequency and the number of pole
pairs.
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Illustration 10.5 Enter Data for Nominal Speed

2. Click OK to get the value.

When the value is calculated, a notification appears. If the
value is out of range, an error message appears and the
value reverts to the previous value.
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Illustration 10.6 Notification Stating that the Value has
Changed
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Illustration 10.7 Error Message when the Value is out of Range
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Changing the number of pole pairs in
parameter 1-25 Motor Nominal Speed also changes the
value of parameter 1-39 Motor Poles.
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Illustration 10.8 Changing Number of Pole Pairs Affects 2
Parameters

PM, Salient IPM
Same functions and behavior as PM, non-salient SPM.
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Illustration 10.9 Examples of Settings for a Non-salient IPM Motor
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SynRM
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Illustration 10.10 Examples of Settings for a SynRM Motor
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11 Multi-Motor Plug-in

In applications where 1 frequency converter controls
multiple motors/fans, a motor or motor/fan coupling failure
may pass unnoticed due to missing feedback from the
controlled fan. One or a few motor failures may be less
critical during low or normal operating load, but it can
lead to a full stop of the system in high-load situations.
The multi-motor plug-in monitors and diagnoses the fan/
motor state. The plug-in is limited to 8 motors of equal
size and type. The multi-motor calculation tool is only for
variable torque applications.

Find the multi-motor plug-in in the drive folder on the left
side of the screen. Use the plug-in either online directly
connected to a frequency converter or offline for
download later. Find the relevant parameters in parameter
group 24-9* Application Functions 2.

NOTICE
The multi-motor plug-in does not work on motors
connected in parallel.

To get the right values, measure the current throughout
the whole frequency band (from 0 Hz to maximum), also
below the normal operating points.

Failures or underload of motors issue a missing motor
warning. The frequency converter continuously checks if
the total motor current is below expected value, which
indicates situations where:

• One or more motors are missing/disconnected.

• One or more fans are loose.

Overload of motors issues a locked rotor warning. The
frequency converter continuously checks if the total motor
current is above the expected value, which indicates
situations where:

• A rotor is locked.

• A fan touches the housing.

NOTICE
During start-up or dynamic events like changes in speed
references, the current may be below/above the current
threshold. Consider and evaluate whether such situations
may occur.

11.1.1 Defining Curves and Thresholds

11.1.1.1 Normal Operation Curve

The plug-in provides an easy way to find the coefficients of
the 3rd order polynomial by measuring currents on
different frequencies.

1. Measure normal operation currents on 5 different
frequencies.

2. Insert the frequencies in Normal operation
currents, see Illustration 11.1.
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Illustration 11.1 Normal Operation Currents

NOTICE
To avoid wrong logical minimum in the 3rd order
polynomial, enter the lowest possible frequency into the
tool.

NOTICE
Points can be inserted at any frequency, but the defaults
are recommended as the points are not saved. Only
calculated coefficients are saved and used to recalculate
the points on default frequencies after closing and
opening the view.
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11.1.1.2 Threshold

Measured points show normal operation curves. Settings in
Motor data, see Illustration 11.2, define the threshold of the
upper and lower limits.
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Illustration 11.2 Threshold

• Number of motors is a convenience value to
reduce the tolerance bandwidth, dividing it by
the number of motors used (maximum 8 motors).

• Tolerance defines the bandwidth as a percentage
of the highest measured current.

NOTICE
These settings are not saved and are recalculated after
closing and opening the view. If the values are different
after recalculation, they still define the same tolerance.
Example: 4 motors with 20% tolerance produce the same
bandwidth as 2 motors with 10% tolerance.

11.1.1.3 Coefficients

Locked-rotor detection and Missing-motor detection, see
Illustration 11.3, show parameter values exactly as they are
written to the frequency converter. The values are
synchronized automatically.
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Illustration 11.3 Locked Rotor Detection and Missing Motor
Detection

NOTICE
Cubic and quadratic coefficients are multiplied by 1000
to overcome precision limitation of parameters.

11.1.2 Modifying Curves

Changing the frequency of a measured point moves the
point along the defined curve. As the point follows the
previously defined curve, the change of frequency only
causes a slight change to the curve.
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12 Cascade Controller Plug-in

The cascade controller is intended for pump applications
where multiple motors control a common flow, level, or
pressure. By varying the speed of the motors, variable
speed control is provided for the system. This maintains
constant pressure while eliminating pressure surges,
resulting in reduced system stress and quieter operation.

3 versions of cascade controllers are available:
• Basic cascade controller

Delivered as part of the software in the VLT®

HVAC Drive FC 102 and VLT® AQUA Drive FC 202.
The 2 relays on the power card control the speed
of a device connected to the frequency converter
output and on/off control devices.

• Extended cascade controller
Allows more devices to be applied to the control
circuitry and offers more cascade principles. It is
available only in the FC 202 with a VLT® Extended
Cascade Controller MCO 101 option card installed.

• Advanced cascade controller offers the cascade
principles similar to extended cascade, but allows
extra devices to be applied to the control
circuitry. It is available only in the FC 202 by
using the VLT® Advanced Cascade Controller MCO
102 option card.

The add-on option cards MCO 101 and MCO 102 can be
used with the basic cascade controller (parameter group 25-
** Cascade Controller) and with the extended/advanced
cascade controller (parameter group 27-** Cascade CTL
Option).

The cascade controller can be configured in MCT 10 Set-up
Software from the cascade controller plug-in. Basic mode
supports the basic cascade controller, and extended mode
supports the extended/advanced cascade options MCO
101/MCO 102.

The MCT 10 Cascade Controller view is divided into 4 tabs
in both cascade modes:

• Preconditions.

• Set-up.

• System Optimizing.

• Service.
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12.1 Preconditions

The preconditions tab contains the general set-up required for the cascade controller to operate in an application. It can
also be used in general to set up the closed loop for other applications without the need for the cascade control. Use
Preconditions to configure:

• General configuration.

• Setpoint and feedback.

• Digital input.

General
configuration

Setpoint and
feedback

Digital input
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Illustration 12.1 Preconditions
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12.1.1 General Configuration

Closed loop is the configuration mode of the frequency
converter. Enabling or disabling the checkbox changes the
parameter 1-00 Configuration Mode parameter.

Options Parameter 1-00 Configuration Mode

Enabled [1] Closed loop

Disabled [0] Speed open loop

Table 12.1 Closed Loop Checkbox Options

Level control configures the inverse mode of the PID
controller. It causes the frequency converter output
frequency to increase when the feedback is greater than
the setpoint reference. If the checkbox is disabled, the PID
is configured to normal control. Digital I/O mode and DI 32
are enabled.
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Illustration 12.2 Level Control

Enabling the checkbox configures the PID to inverse
control and digital I/O mode and DI 32 are disabled. The
frequency converter graphic is updated to reflect the
general configuration.
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Illustration 12.3 General Configuration

The setpoint is used in closed loop as the reference to
compare the feedback values. It can be offset with the
digital, analog, or bus references. Enabling the internal
setpoint allows for entering a numerical value for the
reference source. If the external setpoint is selected, the
reference source is set to AI53. The internal setpoint
settings remain in the field allowing the user to switch
between a preset- or an external setpoint.
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Setpoint and feedback unit type configures the pressure
unit for the closed-loop setpoint and feedback. The
pressure unit can be defined in:

• %.

• mbar.

• bar.

• Pa.

• kPa.

• m WG.

• psi.

• Ib/in2.

• in WG.

• ft WG.

General configuration affected parameters
• Parameter 1-00 Configuration Mode.

• Parameter 20-81 PID Normal/ Inverse Control.

• Parameter 3-15 Reference 1 Source.

• Parameter 20-12 Reference/Feedback Unit.

12.1.2 Setpoint and Feedback

Configure the analog input used as setpoint and feedback.
The general configuration assumes the AI 53 (analog input
53) is used for the setpoint and the AI 54 (analog input 54)
used as feedback. The signal type can only be changed
from current to voltage input with the switches on the
control board of the frequency converter. Click Show
location to see the specific location on the frequency
converter.
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Illustration 12.4 AI53 and AI54

Configure the signal type in accordance with the hardware
switches.
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Push the switch to the left to
get a 0–10 V signal type.

Push the switch to the right to
get a 0–20/4–20 mA signal type.

Table 12.2 Hardware Switches

Setpoint high and Feedback high configure the analog input
scaling value corresponding to the maximum reference
feedback value. Setpoint low and Feedback low are used to
configure the analog input scaling value corresponding to
the minimum reference feedback value. The minimum and
maximum references are the lowest and highest values
obtainable by adding all references together.

To receive notification of a missing or defective transmitter,
define live zero among the functions:

• Off.

• Freeze output.

• Stop.

• Jogging.

• Maximum speed.
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• Stop and trip.

• Select set-up 1.

• Select set-up 2.

• Select set-up 3.

• Select set-up 4.

The function is activated if the signal on terminal AI 53 or
AI 54 is below 50% of the value defined in AI 53 low or AI
54 low. Default Live Zero Timeout time is 10 s and can be
reconfigured in parameter 6-00 Live Zero Timeout Time.

Enable Terminal 53 live zero and Terminal 54 live zero to
disable the live zero monitoring if the analog outputs are
used as part of a decentral I/O system. As default, both
checkboxes are enabled.

Setpoint and feedback affected parameters
• Parameter 3-02 Minimum Reference.

• Parameter 3-03 Maximum Reference.

• Parameter 6-01 Live Zero Timeout Function.

• Parameter 6-10 Terminal 53 Low Voltage.

• Parameter 6-11 Terminal 53 High Voltage.

• Parameter 6-12 Terminal 53 Low Current.

• Parameter 6-13 Terminal 53 High Current.

• Parameter 6-14 Terminal 53 Low Ref./Feedb. Value.

• Parameter 6-15 Terminal 53 High Ref./Feedb. Value.

• Parameter 6-17 Terminal 53 Live Zero.

• Parameter 6-20 Terminal 54 Low Voltage.

• Parameter 6-21 Terminal 54 High Voltage.

• Parameter 6-22 Terminal 54 Low Current.

• Parameter 6-23 Terminal 54 High Current.

• Parameter 6-24 Terminal 54 Low Ref./Feedb. Value.

• Parameter 6-25 Terminal 54 High Ref./Feedb. Value.

• Parameter 6-27 Terminal 54 Live Zero.

12.1.3 Digital Input

If a low-level signal is available, the DI32 (digital input 32)
can be programmed to stop inverse or to external
interlock, and an external interlock delay can be
configured. The type of pulse to trigger can be configured
from the digital I/O mode drop-down list.

12.2 Set-up

The Set-up tab contains the configuration interface for the cascade controller, parameter group 25-** Cascade Controller. The
cascade principle can be configured to Basic Cascade Ctrl or Motor Alternation Only (VLT® AQUA Drive FC 202 only).
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Illustration 12.5 Configuration Interface for Parameter Group 25-** Cascade Controller
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12.2.1 Basic Cascade Control

Select basic cascade control to configure:
• Motor start.

• Pump configuration.

• Staging/destaging settings.
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Illustration 12.6 View of Basic Cascade Control Set-up Tab

View Description

Motor start This view defines the configuration
principle:

• Direct on line – each lag pump is cut in
directly via a contactor.

• Soft starter – must be used for all fixed
speed pumps and can be used to
replace traditional contactors. When
using soft starters, a delay is added from
the staging signal occurs until staging
takes place. The delay is required due to
the ramp time of the fixed speed pump.

View Description

Enable pump
cycling

This view defines whether the pump cycling
is enabled or not:

• Disabled – lag and lead pumps are cut
in to have equal hours run for each
pump.

• Enabled – lag pumps are cut in
according to the first-in, last-out
principle.
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View Description

Fixed lead pump This view defines whether a frequency
converter uses a fixed lead pump or not.
The lead pumps are connected directly to
the relays on the frequency converter
control card. This is shown in
Illustration 12.6.  To obtain equal hours of
operation within the fixed speed pumps,
the lead pump can be alternated. Timers on
the relay outputs monitor the hours run of
each pump. When a pump is not operating
over a long time, corrosion may become an
issue. When it is configured for alternating
lead pump, select Alternation details to set
up principles for alternation.

Lead pump
alternation

This view instructs the frequency converter
to change the lead pump so all pumps run
for the same period. The following options
are available:

• Off – no lead pump alternation occurs.

• At staging – lead pump alternation
occurs at pump staging.

• At command – lead pump alternation
occurs at explicit commands.

• At staging or command – lead pump
alternation occurs at pump staging and
at explicit commands.

Alternation time
interval

In this view, define the time period
between automatic alternations of the lead
pump:

• 1–999.9 h – when the time expires, the
lead pump alternates.

Alternation timer
value

This view contains the actual value of the
alternation timer.

Alternation
predefined time

In this view, set the time to perform an
alternation. The time format depends on
the setting configured in the frequency
converter.

Alternate if load <
50%

In this view, define whether the lead pump
must be alternated:

• Enabled – pump alternation is carried
out only if the capacity is equal to or
below 50%.

Staging mode at
alternation

In this view, configure the staging mode at
alternation and determine the time of the
variable speed pump deceleration:

• Quick.

• Slow.

Delay before
cutting in next
pump

In this view, set the time between stopping
the old lead pump and starting another.
Range: 0.1–5.0 s.

View Description

Delay before
cutting in on mains

Time delay before a fixed speed pump is
staged on according to normal staging
sequence. When it expires, a fixed speed
pump must be staged on according to
normal staging.
Range: 0.1–5.0 s.

Staging/destaging
settings

In this view, configure when to add and
remove a stage from a running application.
A stage is a representation of a 100%
pump.

Staging bandwidth
(SBW)

In this view, define the band around the
head setpoint and configure it as a
percentage of the maximum reference. If
the actual head exceeds the bandwidth for
a specified time and the speed is at motor
speed high limit, a stage is added. If the
speed is at motor speed low limit, a stage
is removed.
Range: 1–100%.

Override
bandwidth (OBW)

Preserves a stable head in the application.
When quick changes in the system
demands occur, the override bandwidth
must add/remove a stage immediately
when the actual exceeds override
bandwidth. To avoid unintended staging
until the head has settled after start,
override bandwidth has a delay until the
lead pump has reached motor nominal
speed or motor speed high limit after a
start command.
Range: SBW to 100%.

Fixed speed pumps
staging bandwidth
(FSBW)

Ensures that the cascade controller
continues, if the frequency converter issues
an alarm. Keeping the head on the setpoint
requires a frequent staging and destaging.
When only fixed speed pumps are running,
a wider bandwidth (FSBW) is used instead
of SBW.
Range: SBW to OBW.

OBW timer Avoids frequent staging/destaging. The
OBW timer prevents staging a pump until
the application pressure is stabilized.
Range: 0–300 s.

SBW staging delay Delay between the feedback signal being
below the staging bandwidth and a lag
pump being added. SBW destaging delay is
the time between when the feedback signal
is above the staging bandwidth and when a
lag pump is removed.
Range: 0–3000 s.
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View Description

Ramp-down delay
and ramp-up delay

For use with soft starters. The ramp-down
delay is for setting the lead pump ramp-
down delay before staging a fixed speed
pump on. Ramp-up delay is for setting the
lead pump ramp-up delay before a fixed
speed pump is destaged.

Stage- and destage
threshold

The percentage of maximum pump speed
to stage on and to destage fixed speed
pump. The thresholds must be configured
as a percentage of motor speed high limit.

Destaging speed To prevent an overshoot when adding a
fixed speed pump, the variable speed pump
ramps to motor speed low limit. When the
variable pump reaches staging speed, the
fixed speed pump is staged on. To prevent
an undershoot when removing a fixed
speed pump, the variable speed pump
ramps to motor speed high limit.
Available options: RPM or Hz.

Enable staging
function

Avoids frequent staging of fixed speed
pumps. Enabling the checkbox starts the
stage function timer. Enable destage
function ensures that the lowest numbers
of pumps are running to save energy and
to avoid dead head water circulation in the
variable speed pump. Enabling the
checkbox starts the destage function timer.

Table 12.3 View and Selection Descriptions

Function Number of pumps

Fixed lead pump 2–3

Alternating lead pump 2

Table 12.4 Number of Pumps Configurable from the
Drop-down List
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Illustration 12.7 Alternation Details

If configuring the lead pump alternation At command or At staging or command, the alternation event can be configured to:
• External – Alternation takes place when a signal is applied to 1 of the digital inputs in the terminal strip.

• Alternation time interval – Alternation takes place every time the alternation time interval expires.

• Sleep mode – Alternation takes place each time the lead pump goes into sleep mode. The no-flow function must
be set to sleep mode or an external signal applied for this function.

• Predefined time – Alternation takes place at a defined time of the day. If Alternation predefined time is set, the
alternation is carried out every day at the specified time.
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Illustration 12.8 Staging and Destaging Details

Stage function time is the time before staging on a fixed
speed if the lead pump is at maximum speed. The stage
timer starts when the adjustable speed pump is running at
motor speed high limit with 1 or more constant speed
pumps stopped. When the timer expires, a fixed speed
pump is staged. The destage function time is the time
before staging on a fixed speed if the lead pump is at
minimum speed. It starts when the adjustable speed pump
is running at motor speed low limit with 1 or more fixed
speed pumps in operation. When the timer expires, a stage
is removed avoiding dead head water circulation within
the adjustable speed pump.

If the Destage at no-flow checkbox is enabled, a stage is
removed when there is a no-flow situation.

12.2.2 Motor Alternation Only

In Motor alternation only, 1 frequency converter and 2
pumps are connected through contactors to both the
frequency converter and to mains. The functionality is used
to allow the alternation between pumps that share a
frequency converter. The alternation takes place at an
external command signal or a preprogrammed event.

12.3 System Optimizing

The System optimizing tab provides a simple way to start
and stop the cascade controller run. It allows for
configuring:

• PID controller.

• Feedback low-pass filter.
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Illustration 12.9 Start and Stop Cascade Controller
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Field Description

PID anti-
windup

Controls the integration of the PID controller. If the
checkbox is enabled, the PID controller stops
integrating the error between the feedback and the
setpoint reference if it is not possible to adjust the
output frequency of the frequency converter to
correct the error. This situation can occur when the
frequency converter has reached the minimum or
maximum output frequency, or when the frequency
converter is stopped. If the checkbox is disabled, the
PID controller continues integrating the error
between the feedback and setpoint reference, even
though the frequency converter cannot adjust its
output frequency to correct this error.

PID
propor-
tional gain

Adjusts the output of the frequency converters PID
controller based on the error between the feedback
and the setpoint reference. Quick PID controller
response is obtained using a large value. If too large,
the frequency converter output frequency may
become unstable. The value is configurable from 0–
10.00.

PID
integral
time

The duration of integrating the error between the
feedback and the setpoint reference to ensure the
error approaches 0. Quick speed adjustments are
obtained using a short duration. At a too short
value, the frequency converter output frequency may
become unstable. The time is configurable from
0.01–10000.00 s.

PID differ-
entiation
time

The time the differentiator monitors the rate of
change of the feedback. If it is quickly changing, it
adjusts the output of the PID controller to reduce
the rate of change of the feedback. Quick PID
controller responses are obtained using a long
duration of time. However, at too large values, the
frequency converter output frequency may become
unstable. Differential time is useful in situations
where fast responses and precise speed control are
required. The time is configurable from 0.00–10.00 s.

Terminal
54 Filter
Time
Constant

A first-order digital low-pass filter constant for
suppressing electrical noise from terminal 54. A high
time constant improves the dampening, but also
increases the time delay through the filter. The value
can only be adjusted while the frequency converter
is stopped. The time constant can be configured
from 0.001–10.000 s.

Table 12.5 Description of PID functions

12.4 Service

The Service tab provides a simple way to make cascade
controller service.

View Description Basic
cascade

controller

Extended
cascade

controller

Cascade
status

 ✓ ✓

Pump
status

Readout of the status for
each pump selected with a
string, which consists of the
pump number and the
current status of the pump.
A readout with 2 pumps
could be 1:D 2:O.

• 1:D – Pump 1 running
on frequency converter.

• 2:O – Pump 2 off.

✓ ✓

Lead pump Shows the actual lead pump
in the application. When an
alternation takes place, the
field is updated to reflect
the current lead pump.

✓ ✓

Manual
alternation

Select a new lead pump.
The items available from the
drop-down list are Off to
the number of pumps.

✓ ✗

Relay status Select relay status to update
the status of the relays.
The status can be

• On - the relay is
activated.

• Off - the relay is
deactivated.

The values can only be
updated if the frequency
converter is online.

✓ ✓

Relay ON
time

Monitors the total hours run
of the connected relay. The
resolution is in hours run.
Reset relay counter resets all
relay on-times. It is only
available, if the frequency
converters are connected
online.

✓ ✗

Pump
interlock

Disables a certain pump and
is configurable from a
checkbox located at each
pump.

✓ ✗
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View Description Basic
cascade

controller

Extended
cascade

controller

Pump ON
time

Monitors the total hours run
of the connected pump. The
resolution is in hours run.
Reset clears the hours run of
a specific pump.

✓ ✗

Current
run-time
hours

Readout of the total number
of hours run for each pump
since last reset. The time is
used to balance the hours
run between pumps.

✗ ✓

Pump total
lifetime
hours

Total hours run for each
connected pump.

✗ ✓

View Description Basic
cascade

controller

Extended
cascade

controller

Manual
pumps
control

Readout of the command
parameter that allows
manual control of individual
pump states.

✗ ✓

Reset relay
counter

Resets all relay on-times.
Only available if the
frequency converter is
online.

✗ ✓

Table 12.6 Service Tab Views
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Illustration 12.10 Service Tab Basic Cascade Controller
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Illustration 12.11 Service Tab Extended Cascade Controller
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View Status Status description

Cascade status Disabled The cascade controller is disabled.

Emergency All pumps have been stopped by a coast/coast inverse or an external interlock command applied
to the frequency converter.

Off All pumps have been stopped by a stop command applied to the frequency converter.

In open loop Configuration mode has been set for open loop. All fixed speed pumps are stopped, and the
variable speed pump continues to run.

Frozen Staging/destaging of pumps has been locked and the reference is locked.

Jogging All fixed speed pumps are stopped. When stopped, the variable speed pump runs at jog speed.

Running A start command is applied to the frequency converter and the cascade controller controls the
pumps.

Running FSBW The frequency is tripped and the cascade controller controls the fixed speed pumps based on
fixed speed bandwidth.

Staging The cascade controller is staging fixed speed pumps.

Destaging The cascade controller is destaging fixed speed pumps.

Alternating The lead pump alternation selection is different than Off and an alternation sequence is taking
place.

Lead not set No pump available to be assigned as variable speed pump.

Pump status X Disabled. The pump is interlocked either via pump interlock or signal on a digital input
programmed for pump interlock in digital inputs.

Off Stopped by the cascade controller, but not interlocked.

D Running on frequency converter. Variable speed pump, regardless if connected directly or
controlled via relay in the frequency converter.

R Running on mains. Fixed speed pump running.

Relay status1) On The relay is activated.

Off The relay is deactivated.

Manual pump

control2)

No operation The function is disabled.

Online Makes the pump available to the cascade controller.

Alternate On Forces the selected pump to be the lead pump.

Offline-Off Turns off the pump and makes the pump unavailable for cascading.

Offline-On Turns on the pump and makes the pump unavailable for cascading.

Offline-Spin Initiates a pump spin.

Table 12.7 Status Descriptions

1) Only available in basic cascade controller.
2) Only available in extended cascade controller.

Relay status enables readout of the function and status of each relay.
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Illustration 12.12 Relay Status

12.5 Extended Cascade Controller Functions

12.5.1 Set-up

Set-up is the interface for setting up the add-on cascade controller option. The Cascade mode drop-down list is extended
with Master/Follower and Mixed Pumps.
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Illustration 12.13 Cascade Mode Drop-down List
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12.5.2 Master/Follower

This view allows configuring:
• Motor start.

• Pump configuration.

• Connections.

• Staging/destaging.

• Master pulse output signal.

• Spin time unused pump.

• Run-time balancing.
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Illustration 12.14 Master/Follower

The motor start drop-down list is similar to the configuration available in chapter 12.2.1 Basic Cascade Control.
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Each pump is controlled by a frequency converter and the number of frequency converters correspond to the number of
pumps. Staging and destaging are done based on the speed of the frequency converter. The constant pressure is controlled
by the master frequency converter operating in closed loop. Up to 6 pumps can be controlled with VLT® Extended Cascade
Controller MCO 101 and up to 8 with the VLT® Advanced Cascade Controller MCO 102.

Select Connections to configure the relay function for each relay in the application.
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Illustration 12.15 Configure Relay Function

NOTICE
The number of available relays depends on the add-on option.

To set up the function of each relay, double-click the Value field and select the relay from the drop-down list. If add-on
option MCO 102 is installed, the relay option VLT® Relay Card MCB 105 may also be used as an expansion.

Select Staging/Destaging settings to configure when to add and remove a stage from a running application. All stages are a
representation of 100% pumps in Master/Follower.
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Illustration 12.16 Staging and Destaging Details

Field Description

Normal
operating
range

The allowed offset from the setpoint before a
pump may be added or removed. The system
must be out of the limit for the time specified in
Staging delay.

Override limit The allowed offset from the setpoint before a
pump immediately is added or removed.

Autotune
stage/destage
threshold

Optimizes the threshold values during operation.
The settings are updated to prevent pressure
overshoots and undershoots when staging and
destaging.

Autotune
stage on/off
speeds

Stage on and off speeds are continually
autotuned during operation. Settings are
optimized to ensure high performance and low
energy consumption.

Table 12.8 Staging and Destaging Descriptions

All supported stages On and Off settings can be
configured in RPM or Hz. Select Example to see a configu-
ration example of 3 pumps.

Ramp-down delay and ramp-up delay are only config-
urable when motor start is configured to soft starter.

Select Master pulse output signal to configure terminal 27
on the master frequency converter.
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Illustration 12.17 Master Pulse Output Signal

In some applications, not all pumps are used regularly.
Select Spin time unused pump to configure the time a
pump is allowed to idle.
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Illustration 12.18 Spin Time Unused Pump

Select Runtime balancing to balance the running hours of
the available pumps. Three balancing priorities are
available for each pump.
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Illustration 12.19 Balance Running Hours

12.5.3 Mixed Pumps

Select Mixed pumps to configure:
• Motor start.

• Pump configuration.

• Pump size.

• Connections.

• Alternation details.

• Staging/destaging settings.

• Spin time unused pump.

• Runtime balancing.

The motor start drop-down list is similar to
chapter 12.2.1 Basic Cascade Control, but with the additional
possibility to configure star/delta.

Mixed Pumps Cascade Mode can be configured to:

Mode Description

Mixed pump A mix of variable speed pumps connected to
frequency converters and more fixed speed
pumps.

Unequal size
pump

Limited mix of fixed speed pumps in
different sizes.

Mixed pump with
alternation

Alternates the frequency converter between 2
pumps along with controlling more fixed
speed pumps.

Table 12.9 Mixed Pump Cascade Modes

Up to 6 pumps can be controlled with VLT® Extended
Cascade Controller MCO 101 and up to 8 with the VLT®

Advanced Cascade Controller MCO 102.

Select Pump size to configure the fixed pump capacity in
the application. All variable speed pumps are read-only
and 100% in capacity.
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Illustration 12.20 Configure Fixed Pump Capacity

For configuration of connection, refer to
chapter 12.5.2 Master/Follower. For mixed pumps alternation
details configuration, refer to chapter 12.2.1 Basic Cascade
Control.

The dialog Staging and destaging details is similar to
chapter 12.2.1 Basic Cascade Control with the additional
option to configure minimum speed destage delay.
Configure for how many seconds the lead pump must run
at minimum speed while system feedback is in normal
operating band. When the time has elapsed, the pump
turns off to save energy.
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Illustration 12.21 Staging/Destaging

Spin time unused pump and Runtime balancing configurations are similar to the master/follower configuration.
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13 Drive File Manager Plug-in

13.1 Customer-Specific Initialization Values - CSIV

The Drive file manager provides the functionality to download files containing customer-specific initialization values (CSIV),
language files, and application wizard files to the frequency converter. CSIV files contain parameter sets that can be used to
initialize the frequency converter to reduce the time for commissioning. Files can only be flashed via the fieldbus RS485 and
USB with the frequency converter serial address configured to 1.

 View drive
flash file
system

Download
CSIV files

Delete CSIV
files

Download
language

files

Delete
language

files

Download
application
wizard files

Delete
application
wizard files

Splash
screen

VLT® Micro Drive
FC 51

N/A N/A N/A N/A N/A N/A N/A N/A

VLT® HVAC Basic
Drive FC 101

N/A N/A N/A N/A N/A N/A N/A N/A

VLT® HVAC Drive
FC 102

Yes Yes Yes Yes Yes Yes Yes Yes

VLT® AQUA Drive
FC 202

Yes Yes Yes Yes Yes Yes Yes Yes

VLT®

AutomationDrive
FC 302

Yes Yes Yes Yes Yes Yes1) Yes1) Yes

Derived versions
of the FC series

Yes Yes Yes Yes Yes Yes Yes Yes

VLT® Advanced
Active Filter AAF
006

Yes Yes Yes Yes Yes N/A N/A N/A

Table 13.1 Available Features

1) Only FC 302 from firmware version 6.6x.

The functionality is available as a plug-in named Drive file
system and is accessible both from network and project
nodes.
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Illustration 13.1 Drive File Manager Plug-In

From the network node, it is only possible to view the
content in the Drive flash file system. It requires a change
of the frequency converter serial protocol
parameter 8-30 Protocol to [1] FC MC. CSIV and language
files can only be downloaded from the project node.
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13.2 Creating CSIV files

New CSIV files can be created by right-clicking from the Drive file manager right pane and selecting New File⇒CSIV File, as
shown in Illustration 13.2. An empty CSIV file is created and listed in the right view with the default name starting from 1.
Also, existing CSIV files or language files can be imported to the list by selecting Import file from the menu.
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Illustration 13.2 Create CSIV Files

CSIV files containing initialization values can be exported to a file by selecting Export File from the menu. Traditionally, from
the file menu it is possible to cut, copy, paste, delete, or rename existing files from the list.
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13.3 Configuring CSIV Files

The CSIV file content is autogenerated based on the settings configured in the File menu.

• Full change set builds up the CSIV file content based on the user-made changes in the project including all the
dependent parameters.

• Minimal change set builds up the CSIV file content based on user-made changes only. Selecting this option, the
CSIV file is independent of the frequency converter firmware version, except if 1 of the user-configured parameters
is not available.

Use an editor to configure the CSIV file. To open the editor, double-click a file from the list or select Edit File from the menu.
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Illustration 13.3 Parameter Settings Imported from the Project and the Actual CSIV File Content

The left view contains the parameter settings imported
from the project. The right view lists the actual CSIV file
content.

• Edit the relevant parameter settings in the Edit
parameters below view.

• It is possible to undo the changes made from the
Options menu.

• Revert parameters to project drive settings apply
the initialization values to CSIV file contents
corresponding to the original project.

• Reset to default values resets all parameters to
factory configuration and erases the CSIV file
content.

• Click Save to save the parameter settings from
the file content to the CSIV file.

• Click Cancel to discard all changes and close the
CSIV editor.

As part of the CSIV content, the frequency converter
information is also saved to the file. When opening the file
in the CSIV editor, a validation is made to check for
compatibility.
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Illustration 13.4 Validation

When parameter settings have been saved to the file, open
it for validation.

13.4 Drive File Manager

Files can be downloaded or existing files erased in the frequency converter from the Drive file manager available from the
menu. See Illustration 13.5.

e3
0b

t8
19

.1
1

Illustration 13.5 Drive File Manager
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The frequency converter is set into service mode when
opening the Drive file manager.

NOTICE
If the connection is lost, or the frequency converter is
power cycled, the frequency converter remains in service
mode. It can be forced back to normal mode with the
Software upgrade plug-in.
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Illustration 13.6 Service Mode

The Drive file manager is divided into a left pane named
Project drive and a right pane named Connected drive.

• Project drive lists the files in the project.

• Connected drive lists the files present in the
frequency converter flash file system.
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Illustration 13.7 Present Files

Three buttons are located in the middle of the view.

The right arrow transfers the files from the project to the
frequency converter flash file system.

Illustration 13.8 Right Arrow

The left arrow transfers the files from the frequency
converter flash file system to the project.

Illustration 13.9 Left Arrow

The Exit button closes the Drive file manager and switches
the frequency converter back to normal mode.

Illustration 13.10 Exit
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14 Functional Safety Configuration Plug-in

14.1 Introduction

The VLT® Safety Option MCB 15x Series is defined in the
safety configuration plug-in:

• Configuration of the safety functions for safe
motion; shuts down the frequency converter if an
error occurs.

• Setting of

- limit values.

- braking ramps for the safety functions.

- monitoring of motion sequences.

The manuals listed below contain important information
about safety systems that must be used to mount and set
up the speed monitoring safety functions of the MCB 15x
module.

2

3

MCT 10

1
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+ +

Illustration 14.1 System Overview

Referenced literature
• VLT®  AutomationDrive FC 301/FC 302 Operating

Guide

14.1.1 Safe Option Compatibility

The VLT® Safety Option MCB 15x Series is supported from
SW version 6.64 of VLT® AutomationDrive FC 301/FC 302.
Previous versions are not supported. MCB 15x Safe plug-in
supports the following fieldbusses:

• Serial communication

- RS232 to RS485

- USB to RS485

• USB

• PROFIBUS DP.V1

The MCT 10 safe plug-in for the VLT® Safety Option MCB
15x Series offers the following features:

• Offline project planning and preparation for
safety functions.

• Commissioning of safety configurations.

• Creating back-ups of safety configurations.

• Safe option diagnostics.

• Monitoring active frequency converters for
behavior and fault codes.
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14.2 Access

14.2.1 Password Management

Access to the VLT® Safety Option MCB 15x Series is
restricted with passwords. The password is requested every
time the user commissions a new set-up for the device.

14.2.2 Safe Plug-in for VLT® Safety Option
MCB 15x Series

To access the safe plug-in for MCB 15x for a frequency
converter, expand the frequency converter’s network or
project view, then expand the relevant frequency converter
to show its contents. See Illustration 14.2.
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Illustration 14.2 The Safe Plug-in for MCB 15x (Safe) shown
with Functional Safety Icon in Project Tree

Click the Safe icon to show the safe plug-in for MCB 15x
plug-in interface in the right view of the MCT 10 Set-up
Software.

If there is multiple separate online or offline frequency
converters, select the relevant frequency converter to
monitor from the structure tree.

NOTICE
The parameters that can be edited using the safe plug-in
for MCB 15x are also included in parameter group 42-**
Safety Functions in the All Parameters group of the
structure tree. These parameters can only be edited
using the safe plug-in for MCB 15x.

To review parameter group 42-** Safety Functions in the All
parameters view, expand the All parameters group beneath
the desired frequency converter and select the 42-** Safety
Functions entity. The parameter grid is shown on the right.
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14.3 Safe Plug-in Interface

The layout of the plug-in is divided into separate sections that are all described in more detail below.
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Illustration 14.3 The Opening Tab of the Safe Plug-in for VLT® Safety Option MCB 15x Series Plug-in Interface (Operating in Offline
Mode)

The safe plug-in for MCB 15x features tooltips for all plug-in interface components. Briefly hovering the mouse cursor over
any interface component reveals a tooltip detailing the current option, LED, or tab header. Refer to these tooltips for quick
and easy help information.
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Illustration 14.4 Tooltip Example

14.3.1 Information and Administration Area

Illustration 14.5 Safe Plug-in for VLT® Safety Option MCB 15x Series Information and Administration Area
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The information area at the top of the plug-in interface
shows the current safe plug-in for MCB 15x profile name
and notifies the user of pending changes.

Depending on the mode, further options are available in
the information area.

• Offline mode: If a frequency converter is
connected, press Write to drive and upload the
configuration to the MCB 15x.

• Online mode: Two more selections are present in
the Information area:

- Administration

- Change password

The Notification icon is shown when there are changes
pending for the frequency converter that have not yet
been written to it. This icon is shown at every configu-
ration update. The icon is removed from the view only
after a successful commissioning procedure.

14.3.2 LED Status Area

The left-hand side of the safe plug-in for the VLT® Safety
Option MCB 15x Series contains the Status pane. The
Status pane contains informative LED status icons that help
to monitor the functionality and status of the safe plug-in
for MCB 15x configuration entities.
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Illustration 14.6 LED Status Area

NOTICE
The LED icons are active only when the safe plug-in for
MCB 15x is accessed in online network mode. When
working in offline project mode, the LEDs remain
inactive (gray).

LED
status Description

Green OK state – the option is enabled or active.

Flashing
green

Pending state – the option is pending. This applies
only to DI1 and DI2 LEDs.

Yellow Active state – the option is active.

Flashing
red

Warning state – the option has encountered a
warning state.

Red Error state – the option has encountered an error.

Gray
Off state – the option is either disabled, offline, or
inactive.

Table 14.1 LED Status Information

DI1 Status of digital input 1.

DI2 Status of digital input 2.

S37 Status of S37 safe output for terminal T37 on the
frequency converter.

STO Status of Safe Torque Off.

SS1-A Status of Safe Stop 1 A.

SS1-B Status of Safe Stop 1 B.

SLS-A Status of safe limited speed A.

SLS-B Status of safe limited speed B.

Power cycle
required

This LED is highlighted when the device requires
a power cycle.

Input offline
test

Digital inputs must be tested once a year. A
warning indicates when it is time to test.

Blank initial If the LED is highlighted, the MCB 15x is in a
blank initial state, that is in factory settings. When
writing to the MCB 15x for the first time, provide
a new password.

Error The MCB 15x has detected an error. The specific
fault code is shown in the fault code display
below the error LED. For more information
regarding fault codes, refer to
chapter 21.3.3 Device Error Codes.

Table 14.2 Safe Option Status LEDs
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14.3.3 Configuration Area

The configuration area contains dedicated sections/tabs for
configuring the safety functions.

The sequence of tabs shows the order in which the
settings should be configured.

The following sections detail the contents of the configu-
ration tabs:

• General speed monitoring

• Safe input

• Safe Stop 1

• Safely limited speed

The last tab, Parameters, contains a table layout of all
configuration options, intended for advanced users.

14.3.4 General Speed Monitoring

The general speed monitoring tab contains primary and general information regarding the encoder/proximity switch
feedback set-up details.
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Illustration 14.7 General Speed Monitoring Configuration Tab
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The left side of the tab contains the following configuration options:

Option Description

Measured
speed source

This option defines the measured speed feedback source. The following options are available:

• Safe plug-in for VLT® Safety Option MCB 15x Series – the feedback source is safe plug-in for MCB 15x.

• None – no feedback source is used.

• Factory default: [Safe plug-in for MCB 15x].

Mounting
type

This option defines the frequency converter mounting type. The following options are available:

• Gear mounted – the frequency converter is mounted using a gear system.

• Motor shaft mounted – the frequency converter is mounted directly to the application.

Gear ratio
This option defines the ratio between motor shaft and the encoder speed.
Range: 0.0001 and 32.0000.
Factory default: 1.0000.

VLT® Safety
Option MCB
150 encoder
resolution

This option defines the encoder resolution connected to the safe plug-in for MCB 15x.
Range: 1 and 4096 PPR for HTL, and 1 and 10000 PPR for TTL.
Factory default is 1024 PPR.

Encoder
direction

This option provides the option to change the detected encoder rotation direction without altering the wiring to the
encoder itself. The following options are available:

• Clockwise – that is positive feedback when the encoder rotates clockwise.

• Counterclockwise – that is positive feedback when the encoder rotates counterclockwise.

Factory default: [Clockwise].

Feedback
type

This option defines the feedback type. The following options are available:

• With direction info – the feedback provides direction information, for example an encoder.

• Without direction info – the feedback does not provide direction information (proximity switch configuration).

Factory default: [With direction info].

Feedback
filter

This option defines the frequency used by the feedback filter for low-resolution encoder or proximity switch. The filter is
required to reduce the quantization noise from the connected encoder or proximity switch if the resolution is low.
Range: 0.01–200 Hz (off).
Factory default: [200 Hz (off)].

Zero speed
timer

This option allows the speed to be below 120 RPM when SLS is active before STO is engaged.
Range: 0 s and 10000 s.
Factory default: [10].

Table 14.3 Options for General Speed Monitoring
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14.3.5 Safe Input

The Safe input configuration tab details the input channel, settings, failure reaction, and reset functions that are mapped into
the VLT® Safety Option MCB 15x Series.
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Illustration 14.8 Safe Input Configuration Tab
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The Safe input tab contains sections and configuration possibilities shown in Table 14.4 –Table 14.7:

Option Description

DI1 safe
function

This option defines the safe function used by DI1. The following options are available:

• STO – Safe Torque Off is used as the safe function by DI1.

• SS1-A – Safe Stop 1 A is used as the safe function by DI1.

• SS1-B – Safe Stop 1 B is used as the safe function by DI1.

• SLS-A – Safe limited speed A is used as the safe function by DI1.

• SLS-B – Safe limited speed B is used as the safe function by DI1.

• Disabled – The DI1 safe function is disabled.

Factory default: STO.

DI1 type

This option defines the DI1 type used. The following options are available:

• NCNC – NCNC type is used.

• Antivalent – NO/NC (antivalent) type is used.

• NC – 1 NC input type is used.

Factory default: NCNC.

DI1 restart
behavior

Restart of the MCB 15x configured the DI1 restart behavior. The following options are available:

• Manual – The restart is performed manually.

Factory default: Manual.

DI2 safe
function

This option defines the safe function used by DI2. The following options are available:

• STO – Safe Torque Off is used as the safe function by DI2.

• SS1-A – Safe Stop 1 A is used as the safe function by DI2.

• SS1-B – Safe Stop 1 B is used as the safe function by DI2.

• SLS-A – Safe limited speed A is used as the safe function by DI2.

• SLS-B – Safe limited speed B is used as the safe function by DI2.

• Disabled – The DI2 safe function is disabled.

• Restart DI1 and Failure ACK – DI1 is restarted.

Factory default: STO.

DI2 type

This option defines the DI2 type used. The following options are available:

• NCNC – NCNC type is used.

• Antivalent – NO/NC (antivalent) type is used.

• NC – 1 NC input type is used.

Factory default: NCNC.

DI2 restart
behavior

This option defines the DI2 restart behavior. The following options are available:

• Manual – The restart is performed manually.

• Automatic – The restart is performed automatically.

Factory default: Manual.

Table 14.4 Options for Safe Input
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Option Description

DI1 discrepancy time
This option defines the time for the DI1 signal discrepancy.
Range: 0–5000 ms.
Factory default: 10 ms.

DI1 stable signal time
This option defines the time for the DI1 signal to become stable.
Range: 0–5000 ms.
Factory default: 10 ms.

DI2 discrepancy time
This option defines the time for the DI2 signal discrepancy.
Range: 0–5000 ms.
Factory default: 10 ms.

DI2 stable signal time
This option defines the time for the DI2 signal to become stable.
Range: 0–5000 ms.
Factory default: 10 ms.

Table 14.5 Options for Input Settings

Option Description

External failure reaction

This option defines the reaction that is executed if there is an external failure. The following options are
available:

• STO – STO is executed.

• SS1-A – SS1-A is executed.

• SS1-B – SS1-B is executed.

Factory default: STO.

Table 14.6 Options for Failure Reaction

Option Description

Reset source

This option defines the source for the reset signal for safe plug-in for MCB 15x. The following options are available:

• Drive Reset – The source is a frequency converter reset.

• Drive Safe Reset – The source is a safe drive reset.

• Safe Option DI2_A – The source is MCB 15x DI2_A.

Factory default: Drive Reset.

Table 14.7 Options for Reset Settings
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14.3.6 Safe Stop 1

The Safe stop configuration tab allows setting specific scenarios for safe stopping of the frequency converters using
designated conditions.
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Illustration 14.9 Safe Stop 1 Configuration Tab
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The Safe stopping tab contains the following separated sections with the following configuration possibilities:

Option Description

Type

This option defines the type of the safe stopping configuration. The following options are available:

• Delay – a delay is used to stop the frequency converter safely.

• Ramp – a ramp is used to stop the frequency converter safely.

Factory default: Delay.

Type: Delay

The following configuration options are available when the type is set to delay:

Delay time

This option defines the amount of time that is used by the SS1 delay function to ramp the
speed down to 0 RPM.
Range: 0.1–3600 s
Factory default: 1 s

Ramp profile

This option defines the ramp profile setting. The following options are available:

• Linear – a linear ramp is used for the delay.

• S-ramp const. time – a constant time ramp is used to stop the frequency converter safely.

Factory default: Linear.

Delta time
This option defines buffer time that is added to the delay time before activating STO.
Range: 0–99%.

S-ramp Ratio start

This option is configurable only when S-ramp constant time is selected as the ramp profile.
This option defines the proportion of the total ramp-down time where the deceleration
torque increases. The greater the percentage value, the greater the jerk compensation
achieved, and thus the lower the torque jerks in the application.
Range: 1–50%.
Factory default: 50%.

S-ramp Ratio end

This option is configurable only when S-ramp constant time is selected as the ramp profile.
This option defines the proportion of the total ramp-down time where the deceleration
torque decreases. The greater the percentage value, the greater the jerk compensation
achieved, and thus the lower the torque jerks in the application.
Range: 1–50%.
Factory default: 50%.

Type: Ramp

The following configuration options are available when the type is set to ramp:

Ramping set-up

This option defines the ramping set-up used. The following options are available:

• Slope – a sloping ramp is used.

• Time – a time ramp is used.

Deceleration rate

This option is configurable only when slope is selected for the ramping set-up. This option
defines the deceleration rate for the SS1 slope-based ramp style.
Range: 1–30000 RPM/s.
Factory default: 1500 RPM/s.

Ramp time
This option is configurable only when time is selected for the ramping set-up. It defines the

time after which safe plug-in for VLT® Safety Option MCB 15x Series engages the STO.

Delta V

This option defines the tolerance between the calculated speed and the actual speed that
the safe plug-in for MCB 15x allows.
Range: 1–10000 RPM.
Factory default: 120 RPM.

Zero speed
This option defines the speed at which safe plug-in for MCB 15x engages the STO.
Range: 1–600 RPM.
The factory default: 10 RPM.

Table 14.8 Options for SS1-A
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Option Description

Type

This option defines the type of the safe stopping configuration. The following options are available:

• Delay – a delay is used to stop the frequency converter safely.

• Ramp – a ramp is used to stop the frequency converter safely.

Factory default: [Delay].

Type: Delay

The following configuration options are available when the type is set to delay:

Delay time

This option defines the amount of time that is used by the SS1 delay function to ramp the
speed down to 0 RPM.
Range: 0.1–3600 s.
Factory default: 1 s.

Ramp profile

This option defines the ramp profile setting. The following options are available:

• Linear – a linear ramp is used for the delay.

• S-ramp const. time – a constant time ramp is used to stop the frequency converter
safely.

Factory default: Linear.

Delta time
This option defines buffer time that is added to the delay time before activating STO.
Range: 0–99%.

S-ramp Ratio start

This option is configurable only when S-ramp constant time is selected as the ramp profile.
This option defines the proportion of the total ramp-down time where the deceleration
torque increases. The greater the percentage value, the greater the jerk compensation
achieved, and thus the lower the torque jerks in the application.
Range: 1–50%.
Factory default: 50%.

S-ramp Ratio end

This option is configurable only when S-ramp constant time is selected as the ramp profile.
This option defines the proportion of the total ramp-down time where the deceleration
torque decreases. The greater the percentage value, the greater the jerk compensation
achieved, and thus the lower the torque jerks in the application.
Range: 1–50%.
Factory default: 50%.

Type: Ramp

The following configuration options are available when the type is set to ramp:

Ramping set-up

This option defines the ramping set-up used. The following options are available:

• Slope – a sloping ramp is used.

• Time – a time ramp is used.

Deceleration rate

This option is configurable only when slope is selected for the ramping set-up. This option
defines the deceleration rate for the SS1 slope-based ramp style.
Range: 1–30000 RPM/s.
Factory default: 1500.

Ramp time
This option is configurable only when time is selected for the ramping set-up. It defines the
time after which the safe plug-in for MCB 15x engages the STO.

Delta V

This option defines the tolerance between the calculated speed and the actual speed that
the safe plug-in for MCB 15x allows.
Range: 1–10000 RPM.
Factory default: [120 RPM].

Zero speed

This option defines the speed at which the safe plug-in for MCB 15x engages the STO.
Range: 1–600 RPM.
Factory default: 10 RPM.

Table 14.9 Options for SS1-B
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14.3.7 Safely Limited Speed

The Safely limited speed configuration tab allows setting specific scenarios for safe limited speeds of the frequency converters
using designated conditions.
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Illustration 14.10 Safely Limited Speed Configuration Tab

The safely limited speed contains the following separated sections with the following configuration possibilities:

Option Description

SLS set-up

This option defines the type of the safely limited speed set-up. The following options are available:

• SLS without ramp.

• SLS with ramp.

Ramp-down time

This option is configurable only when the SLS with ramp is selected in SLS set-up. It defines the ramp-down time
for start ramp.
Range: 0.1–3600 s.
Factory default: 1 s.
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Option Description

Cutoff speed
This option defines the speed at which the failsafe reaction is activated. This setting should equal the value of the
speed limit parameter plus tolerance.
Range: 1–10000 RPM.

Speed limit
This option defines the maximum allowed speed when the SLS function is engaged. This is a speed unit measured
in RPM.

Failsafe reaction

This option defines the safety function that is engaged when the maximum speed is exceeded. The following
options are available:

• STO – Safe Torque Off is used.

• SS1-A – Safe stop 1-A is used.

• SS1-B – Safe stop 1-B is used.

Table 14.10 Options for SLS-A

Option Description

SLS set-up

This option defines the type of the safely limited speed set-up. The following options are available:

• SLS without ramp.

• SLS with ramp.

Ramp-down time

This option is configurable only when the SLS with ramp is selected in SLS set-up. It defines the ramp-down
time for start ramp.
Range: 0.1–3600 s.
Factory default: 1 s.

Cutoff speed
This option defines the speed at which the failsafe reaction is activated. This setting should equal the value
of the speed limit parameter plus tolerance.
Range: 1–10000 RPM.

Speed limit
This option defines the maximum allowed speed when the SLS function is engaged. This is a speed unit
measured in RPM.

Failsafe reaction

This option defines the safety function that is engaged when the maximum speed is exceeded. The following
options are available:

• STO – Safe Torque Off is used.

• SS1-A – Safe stop 1-A is used.

• SS1-B – Safe stop 1-B is used.

Table 14.11 Options for SLS-B
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14.4 Configuration

Configure the safe plug-in in online mode (PC connected
to frequency converter) or in offline mode (no PC
connected to frequency converter). In both cases, enter the
required values in the configuration dialogs to configure
the plug-in.

NOTICE
Multiple value entry fields in the configuration tabs are
accompanied by recommended value settings that
appear below the text field.
The recommended values are generated dynamically
based on the user input of related and dependent
configuration options.
To apply a recommended value to a field, press the
underlined Apply link as it appears below the desired
field.

Offline configuration
When configuring the VLT® Safety Option MCB 15x Series
in an offline project mode, the configuration is stored in
the project. After completing the configuration, connect to
the PC and write to the frequency converter.

NOTICE
The LED status icons are not active in offline mode.

Online configuration
Changed settings within safe plug-in for MCB 15x are not
applied before they are written to the device.

1. Connect the safe plug-in for MCB 15x to the
frequency converter.

2. Click Write to drive to apply changed settings in
the safe plug-in. Writing the values to the
frequency converter always updates the entire
device package and not just the changed values.

NOTICE
If the safe plug-in for the MCB 15x interface is closed
before the changes have been written to the frequency
converter, the changes are lost.

14.4.1 Dependencies

Multiple configurable safety parameters depend on other
safety parameter values. The safe plug-in for VLT® Safety
Option MCB 15x Series features notification dialogs that
inform the user of the possible consequences. It is then
possible to verify the changes and either accept or discard
the change.
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Illustration 14.11 Dependencies Confirmation Dialog

When accepting the dependency dialog, both the change
that caused the dependency dialog and all other configu-
ration items listed in the dependency dialog are applied.
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14.4.2 Advanced Configuration Parameters

In the configuration area, the parameters section is a table format value entry for all configuration settings intended for
advanced users.
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Illustration 14.12 Parameters Configuration Tab

NOTICE
Prepare a complete list of all configuration items and their respective values before commissioning.
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14.4.3 Parameter Lists

Table 14.12 is a complete list of all parameters available to the user for configuration via safe plug-in for VLT® Safety Option
MCB 15x Series.

NOTICE
Parameters ending with .0 are used for either SS1-A or SLS-A. Parameters ending with .1 are used for either SS1-B or
SLS-B in the parameter groups 42-4* SS1 and 42-5* SLS.
For parameter group 42-2* Input .0, refer to DI1 and .1 to DI2.

Parameter Description Factory value

4210 Measured speed source – The source of the speed feedback. Safe option

4211 Encoder resolution – The resolution of the encoder connected to the safe plug-in for MCB 15x. 1024

4212 Encoder direction. Clockwise

4213 Gear ratio – The ratio between the motor speed and the encoder speed. 10.000

4214 Feedback type. With direction info

4215 Feedback filter – The frequency of the feedback filter. 200.00

4218 Zero speed timer – The timer for the zero speed activation. 10

4220.0 Safe function – The safe function selected. STO

4220.1 Safe function – The safe function selected. STO

4221.0 Type – The type of the safe input. NCNC

4221.1 Type – The type of the safe input. NCNC

4222.0 Discrepancy time – The time amount allowed for discrepancy. 10

4222.1 Discrepancy time – The time amount allowed for discrepancy. 10

4223.0 Stable signal time – The time amount for a stable signal. 10

4223.1 Stable signal time – The time amount for a stable signal. 10

4224.0
Restart behavior – The restart behavior of the safe plug-in for MCB 15x, automatic or with user
input. Manual

4224.1
Restart behavior – The restart behavior of the safe plug-in for MCB 15x, automatic or with user
input. Manual

4230 External failure reaction – The safety function that is executed if there is an external failure. STO

4231 Reset source – The source for the reset signal. Drive Reset

4233
Parameter set name – The title for the current safe plug-in for MCB 15x configuration. The
maximum length of the parameter set name is 8 symbols. –

4240.0 Type – Type of the safe stop function. Delay

4240.1 Type – Type of the safe stop function. Delay

4241.0
Ramp profile – The ramp profile that is either defined by the safe plug-in for MCB 15x or within
the frequency converter itself. Linear

4241.1
Ramp profile – The ramp profile that is either defined by the safe plug-in for MCB 15x or within
the frequency converter itself. Linear

4242.0
Delay time – The amount of time spent by the safe stop function to ramp the speed down to
0 RPM. 1.0

4242.1
Delay time – The amount of time spent by the safe stop function to ramp the speed down to
0 RPM. 1.0

4243.0 Delta T – The buffer time that is added to the delay time before activating STO. 2

4243.1 Delta T – The buffer time that is added to the delay time before activating STO. 2

4244.0 Deceleration rate – The deceleration rate for the safe stop slope ramp type. 1500

4244.1 Deceleration rate – The deceleration rate for the safe stop slope ramp type. 1500

4245.0
Delta V – The tolerance between the calculated and actual speeds allowed by the safe plug-in for
MCB 15x. 120

4245.1
Delta V – The tolerance between the calculated and actual speeds allowed by the safe plug-in for
MCB 15x. 120

4246.0 Zero speed – The zero speed limit that the safe plug-in for MCB 15x uses to engage STO. 10

Functional Safety Configura... Operating Guide

MG10RC02 Danfoss A/S © 12/2017 All rights reserved. 121

14 14



Parameter Description Factory value

4246.1 Zero Speed – The zero speed limit that the safe plug-in for MCB 15x uses to engage STO. 10

4247.0 Ramp time – The ramp time that the safe plug-in for MCB 15x uses to engage STO. 1.0

4247.1 Ramp time – The ramp time that the safe plug-in for MCB 15x uses to engage STO. 1.0

4248.0
S-ramp Ratio at deceleration start – The proportion of the total ramp-down time wherein the
deceleration torque increases. The greater the percentage value, the greater the jerk compensation
achieved. 50

4248.1
S-ramp Ratio at deceleration start – The proportion of the total ramp-down time wherein the
deceleration torque increases. The greater the percentage value, the greater the jerk compensation
achieved. 50

4249.0
S-ramp Ratio at deceleration end – The proportion of the total ramp-down time wherein the
deceleration torque decreases. The greater the percentage value, the greater the jerk compensation
achieved. 50

4249.1
S-ramp Ratio at deceleration end – The proportion of the total ramp-down time wherein the
deceleration torque decreases. The greater the percentage value, the greater the jerk compensation
achieved. 50

4250.0 Cutoff speed – The speed at which the failsafe reaction is engaged. –

4250.1 Cutoff speed – The speed at which the failsafe reaction is engaged. –

4251.0 Speed limit – The maximum speed allowed when the safe limited-speed function is engaged. –

4251.1 Speed limit – The maximum speed allowed when the safe limited-speed function is engaged. –

4252.0 Failsafe reaction – The safety function that is activated when the speed exceeds the limit set. STO

4252.1 Failsafe reaction – The safety function that is activated when the speed exceeds the limit set. STO

4253.0
Start ramp – If the speed at the activation of safe limited speed is greater than the speed limit, the
function either ramps down to the speed limit (Yes value) or activates the STO (No value.) No

4253.1
Start ramp – If the speed at the activation of safe limited speed is greater than the speed limit, the
function either ramps down to the speed limit (Yes value) or activates the STO (No value.) No

4254.0 Ramp-down time – The ramp-down time for starting the ramp. 1.0

4254.1 Ramp-down time – The ramp-down time for starting the ramp. 1.0

Table 14.12 Parameter List

14.5 Commissioning

1. Configure a safe plug-in for VLT® Safety Option
MCB 15x Series.

2. Click Write to drive to upload to the frequency
converter.

The status window shown in Illustration 14.13 opens:
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Illustration 14.13 Writing to Drive Status Window

3. Enter the password when the Confirm password
dialog pops up (default password: 12345678). For
more information on changing password, refer to
chapter 14.6.3 Change Password.
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Illustration 14.14 Password Entry Dialog

4. Press OK to continue OR press Cancel to discard
the process and perform a rollback.
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NOTICE
When writing to a device in blank state, the user is
prompted to provide a new password for the device.
Have the appropriate default password available at hand.
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Illustration 14.15 Configuration Approval Dialog and
Summary

Drives The top section of the summary shows all
frequency converters affected by the write
procedure. If there are multiple frequency
converters, press the frequency converter titles in
the window to update parameters and CRC
accordingly.

Parameters This section details all the updated parameters that
were written to the frequency converter.

ID The parameter ID written.

Name The name of the parameter written.

New values The value of the parameter that was designated to
be written to the frequency converter. This column
must have the same value as Received values.  If not,
an error is shown.

Received
values

The value that was received from the frequency
converter after the update procedure. This column
must have the same value as New values.  If not, an
error is shown.

CRC This section shows the CRC values that were
generated from the application side and the
frequency converter side. These values must match.
If not, an error is shown.

Table 14.13 Explanations for Illustration 14.15

5. When the configuration approval pops up, review
the included summary.

6. Press Approve to confirm the changes and close
the dialog window, OR press Cancel to discard the
process and perform a rollback.

When the configuration is approved, the commissioning
report is generated and shown.
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Illustration 14.16 Commission Report Review, Save, and Print
Dialog

7. Press Save to save the commission report in Rich
Text Format.

8. Press Print to print the report.

9. When the commissioning process is complete,
press [Reset] on the frequency converter to
reboot.

14.5.1 Commission Report

During the commission process, the commission report is
generated based on a fixed template within the MCT 10
application. The report contains all data written to the
frequency converter.

The report is generated during the write-to-drive procedure
and the data is gathered at the moment the report is
generated. This report contains the functions that must be
tested, see more details in VLT®  Safety Option MCB 150/151
Operating Instructions and in VLT®  Safety Option MCB 152
Operating Instructions.
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The contents and structure of the commissioning report
are as follows:

• General introduction – general information and
details about the report itself.

• Commissioning configuration – details regarding
the commissioned set-up and parameter configu-
rations.

• Commissioning test – specific testing scenarios
for the current set-up. This section also contains
CRC check procedure descriptions.

14.6 Operation

The following sections describe how to use the diagnostics
function, how to reset, and how to change password.

14.6.1 Diagnostics

Follow these instructions to access and use the Diagnostics
function:

1. Open the safe plug-in for VLT® Safety Option MCB
15x Series plug-in interface in network online
mode.

2. Click Administration in the upper section of the
interface. The window shown in Illustration 14.17
opens:
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Illustration 14.17 Safe Plug-in for MCB 15x Administration
Window

3. Enter the safe plug-in for MCB 15x password
configured for the frequency converter.

4. Click Download to download the safe plug-in for
MCB 15x event log.

5. Select a location to save the log file. The log is
presented in simple text file format.

14.6.2 Reset

Follow these instructions to access and use the Reset
function:

NOTICE
Resetting the device restores factory settings and erases
any customized configuration on the device. To ensure
rollback possibility, back up the customized configu-
ration before resetting.

1. Open the safe plug-in for VLT® Safety Option MCB
15x Series plug-in interface in network online
mode.

2. Click Administration in the upper section of the
interface.

3. Click the Reset tab header to open the Reset tab.
The following window opens:
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Illustration 14.18 Reset Password

4. Tick Yes, I want to reset Safe Option Configuration
in the Drive for the frequency converter to
continue.

5. Enter the master password configured for the
frequency converter to continue.

6. Press Reset to reset the frequency converter
password and configuration.

7. Press [Reset] on the frequency converter to
reboot.

Functional Safety Configura... VLT® Motion Control Tools MCT 10 Set-up Software

124 Danfoss A/S © 12/2017 All rights reserved. MG10RC02

1414



14.6.3 Change Password

When working with the safe plug-in for VLT® Safety Option
MCB 15x Series plug-in in network online mode, Change
password is shown in the information area of the plug-in
interface.
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Illustration 14.19 Safe Plug-in for MCB 15x Password
Changing Window

Follow these instructions to change the password:
1. Click Change password.

2. Enter the current password into the Current
password field.

3. Enter the new desired password into the  New
password field. The password length must be
exactly 8 characters. The password is case-
sensitive.

4. Confirm the new desired password by entering it
again into the Confirm new password field.

5. If necessary, select the option Confirm to all blank
initial drives to apply the new password to all new
drives in the network.

6. Click Cancel to discard the procedure.
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15 Status Plug-in

The Status plug-in is an online plug-in that shows the
digital status words, control words, and alarm words.
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Illustration 15.1 Selecting the Status Plug-in

The plug-in only shows the available parameters. For each
control word and status word, it shows the value in hex,
reference, and control word profile. The plug-in shows all
bits. Active bits (value = 1) are marked by a green LED,
while inactive bits are marked by a gray LED. The
highlighted text shows the meaning of the bit status.
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Illustration 15.2 Example of Bit Status for Control Word

An information symbol in the left column of the screen indicates that a parameter has extra information. See Illustration 15.2
for an example. Click the information symbol to get information about a bit.
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Illustration 15.3 Example of Bit Information
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Illustration 15.4 Example of Maintenance Word
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Illustration 15.5 Example of Digital Input

NOTICE
When bit 6 is active, the signal on DI 37 is inactive,
meaning that there is no signal present on the input.

Status plug-in used with fieldbusses
All fieldbusses supported by MCT 10 Set-up Software
support the Status plug-in. While the plug-in is open, MCT
10 reads the visible parameter constantly. This way, the
plug-in updates automatically when values change.

Loss of communication
If communication is lost, the plug-in turns yellow and
sends a notification. The latest values are kept as they
were before the communication loss. When communication
is recovered, the plug-in recovers automatically.
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16 Drive Control Plug-in

The Drive Control plug-in is available for online frequency
converters in the following product series:

• VLT® HVAC Drive FC 102

• VLT® AQUA Drive FC 202

• VLT® AutomationDrive FC 301/FC 302

The plug-in is supported by serial communication and USB.

For the plug-in to work, it is required to be connected to
the frequency converter that should be controlled.

To open the plug-in, select Drive control in the structure in
the left window.
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Illustration 16.1 Drive Control in Structure

A temporary page opens for accepting risks and
configuring important parameters.
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Illustration 16.2 Risks to Accept

Drive Control Plug-in VLT® Motion Control Tools MCT 10 Set-up Software

128 Danfoss A/S © 12/2017 All rights reserved. MG10RC02

1616



To be able to launch the Drive Control plug-in, it is
required to accept the risk.

1. Tick I accept the risks.

2. Click Launch Drive Control.
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Illustration 16.3 Launch Control Button

Launching Drive Control opens the window shown in
Illustration 16.4.
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Illustration 16.4 Drive Control Window

At launch, the control word is set to 0400 but is not yet
sent to the frequency converter.

There are 2 ways of setting the control word:
• Use the checkboxes.

• Type the value directly in the Request in Hex field.
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Illustration 16.5 Checkboxes for Setting Control Word
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Illustration 16.6 Typing in the Value Directly
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Illustration 16.7 Control Word Set
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When the control word is set, the control can be started.
1. Click Start control. The plug-in starts sending the

control word and then reads the status word.
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Illustration 16.8 Start Control Button

The control word is sent cyclically until clicking Stop control
or until communication fails. The control state bar runs
while the control word is being sent.
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Illustration 16.9 Control State Bar Running

After a successful reading of a status, a notification is sent.
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Illustration 16.10 Last Status Read Successfully

At loss of communication, the bits of the status view turn
yellow, and an error appears.
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Illustration 16.11 Loss of Communication
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Illustration 16.12 Error at Loss of Communication

Changing control word bits
Control word bits can be changed while the control word is being sent. While changing the control word, the values of
Request in hex and Current outgoing request differ.
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Illustration 16.13 Request in Hex
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Illustration 16.14 Values of Current Outgoing Request

To change the control word to the new value, click Update outgoing request.
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Illustration 16.15 Update Outgoing Request Button

After clicking Update outgoing request, the values are the same.
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Illustration 16.16 Values Aligned in Request in Hex and Current Outgoing Request

Changing the reference
Change the reference by either entering the hex value
directly in Request in hex, or enter the value in either
decimal or percentage.

Values out of range are shown in pink.
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Illustration 16.17 Value Out of Range

The Update outgoing request button is disabled until a valid
value is set.

While Drive Control plug-in is open
When the Drive Control plug-in is open, the bus is locked,
and it is not possible to scan or change parameter values.

It is possible to create a scope folder in a project that
allows monitoring of relevant parameters while changing
the control word via Drive Control.
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Illustration 16.18 Create Scope Folder in Project

Once the Drive Control plug-in is closed, the control word
is restored to the value it had before starting the plug-in.
Also other parameters are only changed temporarily.

NOTICE
Control word and other parameters used by Drive
Control are written to flash instead of EEPROM. When
power cycling the frequency converter, these values are
restored to the values they had before the Drive Control
was started. If Drive Control of MCT 10 Set-up Software
closes abnormally, the parameter restore process is not
done.
Troubleshooting
To restore the values after an abnormal shutdown, power
cycle the frequency converter.
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17 Decoder Plug-in

Use the Decoder plug-in for decoding Safe Option log files.
The decoded log files are shown both inline (all
information shown in 1 line) and as an overview of a
selected line.

To start the plug-in:
1. Click the Tools menu.

2. Select SafeOption Log Viewer.
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Illustration 17.1 Selecting the Plug-in

3. Click Browse to select a file.
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Illustration 17.2 View of the Log Visualizer

4. Click the arrow button to expand the log area or
the explanation area.

e3
0b

t9
86

.1
0

Illustration 17.3 Expanding the Views
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Illustration 17.4 Log File Shown in Log Visualizer

Files that require decoding have a 1-line explanation in the
explanation area (right window). To get a better overview
of a failure description, select the failure to see an
overview of the description at the bottom of the window.

Illustration 17.5 Failure Shown as Inline Text
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Illustration 17.6 Overview of Failure Description
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18 Support of VLT® Wireless Communication Panel LCP 103

MCT 10 Set-up Software supports the VLT® Wireless Communication Panel LCP 103. There are 2 different approaches
depending on the MCT 10 version used.

With MCT 10 Set-up Software Basic Version

1. Right-click the frequency converter that has the LCP 103 plugged in.

2. Select Update WIFI LCP firmware.

3. In the dialog box, select a file (*.bin is already selected).

4. Press [OK].

When the procedure is completed, the writing starts and the progress is visible.
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Illustration 18.1 Dialog for Selecting *.bin Files
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Illustration 18.2 Progress Bar Showing While Writing to the Drive

NOTICE
If errors occur, they are shown in the Customizing drive
dialog box, see Illustration 18.2. If writing is successful,
the dialog box closes automatically.
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With MCT 10 Set-up Software Advanced Version
With the advanced version of the MCT 10 Set-up Software,
the Drive File Manager Plug-in can be used for connecting
the LCP 103.

1. In the offline frequency converter, select Drive File
System.

2. Right-click in the right window and select Import
file from the context menu.

e3
0b

t8
73

.1
0

3. In the dialog box, select binary files (*.bin).
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4. Select the correct binary file.

4a Selecting a wrong file issues an error
message.
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4b After a successful file import, the Drive
File System shows information about the
file.
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5.

Press  to launch Drive File Manager.

6. Via the Drive File Manager, write the *bin file to
the frequency converter.
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19 VLT® Software Customizer

19.1 Introduction

The VLT® Software Customizer is available from MCT 10 Set-up Software version 4.00. The tool enables customization of the
frequency converter by modifying or creating unique splash screens, initial values, and SmartStart wizards.

The plug-in contains 3 independent features:
• SplashScreen: Add a custom logo that is shown during initialization of the frequency converter. The SplashScreen

supports:

- jpeg

- png

- bmp

- gif

• InitialValues: Define unique parameter default values based on application needs in a customer-specific initial
values (CSIV) format. Every time the frequency converter is initialized, it starts with the custom values.

• SmartStart: Create custom SmartStart wizards that guide through predefined application steps, which simplifies the
commissioning process.

Furthermore, it is possible to write to the frequency converter and test in the simulator. The Write to drive function writes
files that have been created or imported into VLT® Software Customizer. Test in simulator launches the LCP simulator for
simulating being connected to a frequency converter. In the Settings menu, it is possible to show or hide the disclaimer.
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Write to drive
Test in
simulator

Settings

Illustration 19.1 Tool Tips for Navigation and Support
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Illustration 19.2 A Mouseover Highlights the Area Pointed at

When doing a mouseover on 1 of the 3 features, the feature is highlighted, and a button is available. Click the button to
open the functions currently available for the selected feature.

Illustration 19.3 Button for Opening Available Functions
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Illustration 19.4 Example of Available Options for a Feature
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19.1.1 Activation Key

The VLT® Software Customizer is an advanced tool that requires an activation key. To obtain the activation key, contact the
local Danfoss representative.
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Illustration 19.5 Dialog Box for Entering the Activation Key

19.1.2 Disclaimer

When the activation key is active, a disclaimer appears.
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Illustration 19.6 Disclaimer

Click OK to make the disclaimer disappear until the next
restart of MCT 10 Set-up Software.

To avoid seeing the disclaimer at each start-up, tick the Do
not display again.

To change the settings for the disclaimer at a later point:
1. Select Settings in the top menu.
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1a Tick and click OK to show the disclaimer
at each start-up.

1b Remove the check mark and click OK
not to show the disclaimer at each start-
up.
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19.2 SplashScreen

Use the SplashScreen tool to create images to be shown
on the LCP while the frequency converter initializes.

Either create a splash screen from new, import an existing
SplashScreen file, or import a picture.

19.2.1 New from Blank

1. Select New from blank to open the editor with an
empty project.
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Illustration 19.7 Empty Project in Editor

2. Use the different tools in the menu to create the
drawing. Width increases/decreases brush line
thickness, left mouse button is for freehand line,
right mouse button for straight lines.

Undo
Width of
brush Eraser

Continue
to save

Cancel
workflow

Paste
from
clip-
board

Redo Brush Clear Zoom of
LCP area

About
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Illustration 19.8 Drawing Tools

3. When finished, click Continue.

4. In the dialog box, enter a file name and click
Finish. Clicking Back returns to the editor, clicking
Cancel cancels saving of the file.
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Illustration 19.9 Dialog Box for Saving a SplashScreen Image

19.2.2 Select from Library

Use Select from Library to open already saved SplashScreen
files (*.spla).

Select from Library is also used for editing already saved
SplashScreen files.

19.2.3 Import

The import function allows import of:
• jpg

• jpeg

• bmp

• png

• tif

• gif

• spla

• splash

At import, the picture resizes to fit the LCP. If the entire
picture is not visible, set the threshold value of the
imported image.
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Illustration 19.10 SplashScreen with Original Threshold Value
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Illustration 19.11 SplashScreen Improved with Higher Threshold Values

The quality of the imported picture can be improved further by using the brush.
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Illustration 19.12 SplashScreen Improved with the Brush Tool

When the picture is saved, the SplashScreen is added into the VLT® Software Customizer project along with a date and time
stamp. It is possible to edit and save more SplashScreen files, but only 1 appears in the project.
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Illustration 19.13 SplashScreen and Preview Added to Project

Adding a SplashScreen to the project, changes the menu to offer the functions in Illustration 19.14.
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Illustration 19.14 Functions in the SplashScreen Menu
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19.3 InitialValues

Use InitialValues to create CSIV files. Without a CSIV file, all parameters are reset to default values during initialization of the
frequency converter. With a CSIV file, parameter values are initialized with the values defined in the CSIV file.
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Illustration 19.15 InitialValues Menu

19.3.1 New from Blank

1. Select New from Blank to open an empty project in the editor.
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Illustration 19.16 Example of Empty Project
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2. To add parameters, double-click in a parameter and change a value. For example, add German to the CSIV.
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Illustration 19.17 Setting a Value for the CSIV File

3. Click OK to add the value to the CSIV file.
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Illustration 19.18 Value Added to CSIV File

Alternatively, use filters to easily find parameters to add to the CSIV file. Search by the parameter name or ID.
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Illustration 19.19 Example of Using Filters for Finding Parameters

To import a parameter available in the offline MCT 10 Set-
up Software project, click:

Illustration 19.20 Button for Applying Parameters that are
Available Offline

1. To remove a parameter, select the parameter to
be removed.

2. Click Reset selected parameter values to default.
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Illustration 19.21 Removing a Parameter

NOTICE
When resetting a parameter, other parameters may
disappear from the CSIV file or change their values due
to dependencies.
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When the CSIV file is complete:
1. Click Continue.

2. In the dialog box, enter a file name.
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3. Click Finish. Clicking Back returns to the editor,
clicking Cancel cancels saving of the CSIV file.

When saving the CSIV file has completed, a preview of the
file is shown in the project along with a date and time
stamp.
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Illustration 19.22 Preview of CSIV File in Project

19.3.2 Import

Parameters are validated during import of a CSIV file. Incompatible parameters cannot be imported and are highlighted.
Incompatibilities can be caused by, for example, missing parameters or a CSIV file created for a different product series.
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Illustration 19.23 Example of Incompatible Parameter

To copy the shown incompatibilities into Word or Notepad,
click Copy incompatibilities.

To remove the incompatible parameters, click Remove
incompatibilities.

It is possible to check the content of multiple CSIV files at
import. Click Select other in the top left corner to open a
Windows folder for selecting other CSIV files.
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19.4 SmartStart

Use SmartStart to create set-up wizards that make commissioning of the frequency converters easier and faster. The
SmartStart wizard is a series of steps ensuring accurate and efficient motor control.
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Illustration 19.24 SmartStart Menu in Project

NOTICE
In SmartStart, it is not possible to import existing binary
files (*.sas files). First, create a wizard model. This model
is converted into WDL scripting language, which is then
compiled into a .sas binary file.

The SmartStart feature is based on the Model Drive
Architecture® (MDA) standard by Object Management
Group (OMG).

MDA

MDA® is a set of guidelines for structuring specifications
that are expressed as models.

MCT 10 Set-up Software allows OEMs to participate in the
process of SAS engineering and specifying Smart Set-up
behavior as model. MDA defines 4 model layers, where the
wizard designer operates on layer M1.

OMG

OMG® is an international non-profit technology standards
consortium and is best known for standards distributed
computing (CORBA) and modeling (UML).

OMG develops standards for a wide range of technologies
and industries but does not provide implementations of
them.

19.4.1 New from Blank

The SmartStart tool is organized in the following areas:
• Palette

• Menu

• Overview

• Properties

• Main/design area
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Procedure
1. Select New from Blank to open an empty project

in the editor.
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Illustration 19.25 Empty Project

2. Create the diagram in the main/design area.

19.4.1.1 Palette
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Add note, text, or an attachment
to the design

Zoom in - Left click
Zoom out - Shoft + left click
Zoom to selection - Drag

Select

Zoom out - Left click
Zoom in - Shift + left click

Illustration 19.26 Description of Icons in the Menu
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Add screen for revising 
a parameter

Merge multiple branches
into a single branch

Connect screens by
links to specify set-up flow

Connect the starting point
to the screen that should be
shown first

Add conditional branching
to set-up flow

Quit the set-up and
show drive status
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Illustration 19.27 Description of the Elements for Creating Diagrams

19.4.1.2 Menu

Redo Copy selection
as image

Undo

Delete selection

Save diagram
as image file

e3
0b

t9
15

.1
0

Illustration 19.28 Description of Icons in the Left Menu Section

Select all, select all shapes,
sellect all connectors
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Illustration 19.29 Description of the Select Section in the
Menu

VLT® Software Customizer Operating Guide

MG10RC02 Danfoss A/S © 12/2017 All rights reserved. 151

19 19



Arrange all,
arrange selection

Auto
size

Select to have visible grid,
ruler, and if elements should
snap to grid or be placed
anywhere

About

Select all, 
select all shapes,
select all connectors

Different alignments
for the diagram:
Left, center, right,
up, middle, bottom

Shows or hides
connector labels

Different
types of zoom

Show key assist
(Ctrl+shift+L)
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Illustration 19.30 Description of Icons the Menu

19.4.1.3 Overview

The overview section gives an overview of the diagram as it starts to grow. The overview makes it easier to navigate.
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Illustration 19.31 Example of Diagram Shown in the Main/Design Area and in the Overview
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19.4.1.4 Properties

The Properties view shows the property of a selected
element in a diagram.
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Illustration 19.32 Example of Properties for Parameter (Screen)
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Illustration 19.33 Example of Properties for Link

19.4.2 Create Diagram

Create a diagram in any of 3 ways:
• Drag and drop the element into the Design area.

• Select an element by clicking it and then click in
the Design area where the element should be
placed.

• Leave the mouse cursor for 1 s on the Design
area and small elements appear. Then select the
needed element.
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Illustration 19.34 Elements for Creating Diagrams

NOTICE
It is only possible to have 1 starting point. Once a
starting point is inserted in the diagram, the element is
grayed out in the element list.
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19.4.3 Create Parameter Screen

After selecting or dropping a parameter screen into a
diagram, a Create parameter screen dialog appears.
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Illustration 19.35 Create Parameter Screen Dialog
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19.4.3.1 Filter

Filter parameters by typing the parameter name or ID.
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Illustration 19.36 Example of Filtering

Filtering shows the 1st parameter that matches the search,
and the groups and subgroups where the match is
available.

While creating Parameter Screen, it is possible to filter
choice lists and index parameters available in the wizard.
Make the selection from Valid choices.
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Illustration 19.37 Example Showing Available Languages

For index parameters, an index filter dialog box is shown.
By default, all possible indices are selected. Use ”-” for a
range of filters, or use “,” for selecting individual indices. It
is also possible to combine the selections.
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Illustration 19.38 Example of Index Parameter with Index
Filter
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Illustration 19.39 Example of Individual Selection
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Illustration 19.40 Example of Combined Selection
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Illustration 19.41 Error Message when Filter is Wrong

NOTICE
When the filter is wrong, it is not possible to click OK
until the error has been corrected.

19.4.3.2 Customize Parameter Display
Name

Parameter names can be customized and shown in the
wizard. Type the new parameter name in the field
Parameter display name.
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Illustration 19.42 Example of a Customized Parameter Name
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Illustration 19.43 Customized Parameter Name Shown in the
LCP
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Illustration 19.44 Example of Customized String Shown in the
LCP

A customized name is shown in the diagram and in
Properties.

Illustration 19.45 Customized Name Shown in the Diagram
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Illustration 19.46 Customized Name Shown in Properties

19.4.3.3 Help Text

It is possible to define help texts for the parameter screens.
The maximum character number for a help text is 511. To
show a help text, press the [Info] key on the LCP.
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Illustration 19.47 Example of Help Text
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Illustration 19.48 Help Text Shown in LCP After Pressing Info

19.4.4 Link

Link between screens in 2 ways:
• Select the Link icon from the palette.

• Use connectors to link elements.

Linking via the palette

1. Drag the Link icon and drop it on the element to
link from.

2. Drag down to the element to link to.
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Illustration 19.49 Link from the Palette
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Link via connectors

1. Select the elements to connect (leave the cursor
over the element for connectors to appear).
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2. When the connector is shown, drag and drop it
on the element to connect to.

When the connection is established, an arrow is shown
and a label added.
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Illustration 19.50 Established Connections with Label Added

Double-clicking the link opens the link properties. Use the
link properties to add action scripts.
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Illustration 19.51 Link Properties

19.4.4.1 Action Scripts

Action scripts are for advanced users. It is required to know the expected format.

Use the scripting assistant to create an action script for parameter initialization in any place where parameters are selected
from a list.

Example

• Initialize parameters: P=value

• Comments: Comments start with “;”
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Illustration 19.52 Example of Action Script

The action script is added to the diagram as a label.
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Illustration 19.53 Action Script Added to Diagram as Label

19.4.5 Branching

Use branching for having 1 point with several options.
Each option has a guard condition that must be fulfilled
for that option to be selected. Click [TODO] to specify the
guard condition.
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Illustration 19.54 Click [TODO]
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Illustration 19.55 Window for Defining Guard Conditions

The scripting assistant for guard conditions opens a dialog.

1. Select the parameter number.

2. Select comparison operator.
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3. Select value.
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Illustration 19.56 Example of the Guard Scripting Assistant
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Illustration 19.57 Example of Branching with 2 Options
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Illustration 19.58 Example of Branching with 4 Options

19.4.6 Junction

Junction is used for chaining multiple transitions. A single
junction can have 1 or more incoming transitions.
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Illustration 19.59 Example of Junction with Several Transitions

19.5 Writing to Drive

NOTICE
TURN OFF FREQUENCY CONVERTER
Writing to drive puts the frequency converter in test
monitor mode. This is a special mode where it is possible
to write files to flash the file system. It is important to
turn off the frequency converter.

Writing to drive writes files from the VLT® Software
Customizer.

If a file is already in the frequency converter, it is
overwritten by the new file.
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19.5.1 Preserve Original vs Wipe Original

Write to drive writes all files. If a feature does not contain
any files, select either to keep the original file in the drive,
or to delete it (Wipe Original). By default, Preserve Original
is selected. To change this, select it from the menu of the
given feature.
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Illustration 19.60 Menu for SplashScreen

Changing from Preserve Original to Wipe Original issues a
notification.
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Illustration 19.61 Notification when Changing Setting

After pressing [OK], the new setting is shown in the
project.

e3
0b

t9
54

.1
0

Illustration 19.62 New Setting Shown in Project

The settings are individual for each feature. If a feature
already has a file in the project, this setting is irrelevant
and therefore grayed out.
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Illustration 19.63 Example of Grayed-out Setting

NOTICE
To make back-up of files in the file system, use the Drive
File System and the Drive File Manager, see
chapter 13 Drive File Manager Plug-in.

19.6 Remove

To remove a file, select Remove from the given feature
menu in the project.
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Illustration 19.64 Removing a File

19.7 Test in Simulator

Use the simulator to test created files without being connected to a real frequency converter and a real LCP. The simulator is
an app that emulates LCP behavior.

e3
0b

t9
57

.1
0

Illustration 19.65 Select Test in Simulator in the Top Menu

Each frequency converter series and each software version
have different simulators.

If the simulator is not available when selecting Test in
Simulator, a message is shown.
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Illustration 19.66 Warning Message - Simulator is not Installed

If the simulator is not available, contact a local Danfoss
representative who can provide a zip file.

Installing the simulator

1. Save the zip file locally on a PC.

2. Open the Tools menu in MCT 10 Set-up Software.

3. Select Update VLT Software Customizer support....

4. Select the zip file stored on the PC.
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Illustration 19.67 Selecting the Update VLT Software
Customizer Support
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Illustration 19.68 LCP Simulator
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20 SyncPos

20.1 SyncPos Handling

The VLT® 5000 and VLT® 5000 FLUX series have a SyncPos
application option, which consists of a print card with a
processor. For detailed information, refer to Programmable
SyncPos Motion Controller Operating Instructions.

MCT 10 Set-up Software can directly modify, read from,
and write to SyncPos files. SyncPos files are stored within
the MCT 10 Set-up Software files and do not require
separate handling.

When a VLT 5000 has a SyncPos option installed, the MCT
10 Set-up Software shows 2 icons after the frequency
converter has been selected:

• An All parameters folder icon.

• A separate SyncPos icon.

Parameter group 7-** Controllers is incorporated under All
Parameters and applies to SyncPos.

NOTICE
MCT 10 Set-up Software does not fully support the
SyncPos application versions 1.xx and 2.xx. The SyncPos
folder is available due to the lack of functionality in
these initial versions.

20.2 Programs and Configuration File

The SyncPos program consists of 2 main parts:
• Configuration file (*.cnf ).

• Program Files(s) (*.m).

A configuration file consists of a series of SyncPos
parameters which can be programmed. MCT 10 Set-up
Software allows importing, exporting, and setting up
SyncPos configuration files.

20.2.1 Programs

Programs can be inserted in the MCT 10 Set-up Software
Project folder. When a new SyncPos program is selected,
an untitled program is inserted in the SyncPos folder. The
program can be edited, written, and exported as in the
standalone SyncPos program. If a SyncPos program exists,
it can be imported into the MCT 10 Set-up Software
project.

20.2.2 Configuration

1. Select Configuration to view the available
frequency converter configuration file in the right
view.

2. To change the SyncPos settings, select the
relevant frequency converter in the right view to
open a new editor (Cam Editor). Refer to
Programmable SyncPos Motion Controller Operating
Instructions for details on using the editor.

3. Once the desired settings are made, select
Compile (under Settings in the main menu) or Exit
Program (under File in the main menu).

4. When selecting Exit Program, select Read or Write.
The Confirm SyncPos write (or read) window pops
up with 2 options for saving to the SyncPos card.
Mark the desired selection and select Yes or No.
When selecting Yes, the information is written to
the frequency converter.

NOTICE
If Write to Drive is selected at the root of a frequency
converter, the MCT 10 Set-up Software also writes the
SyncPos files to the SyncPos options. This can lead to an
unattended stop of the SyncPos card.
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20.2.3 Import and Export of a Configuration File

To import a configuration file saved elsewhere, for example in another project, to the SyncPos card:
1. Click the configuration file shown in the right view, see Illustration 20.1.

2. Select a configuration file for import from the computer directory.

3. Select the desired file and click Open to import the file to the Configuration folder.
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Illustration 20.1 Import Configuration File
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Illustration 20.2 Import Configuration File

Export of configuration files is performed in the same manner.
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20.2.4 Edit and Save Configuration File

View and edit the content of the configuration file by
selecting it. The configuration editor then opens.

After editing is complete, close the SyncPos application
and the window shown in Illustration 20.3 pops up:
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Illustration 20.3 SyncPos Application Closed

Select Read to save changes to the MCT 10 Set-up
Software project, or Write to save changes to the frequency
converter. Reading or writing can take some time.

20.2.5 Import and Export of Programs

To import a program to the SyncPos card, left-click on a program shown in the right view as shown in Illustration 20.4.
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Illustration 20.4 Import Program to SyncPos Card

Browse the computer to find the desired program for import.
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Illustration 20.5 Browse

Select the desired program, click Open to import program in the Programs folder. The import is now complete.

20.2.6 Auto Start

If more than 1 program is stored in the Programs folder, it is possible to set 1 of them to start automatically when the
device is turned on.

In the right view, select the start-up program, and then right-click to select Set As Auto Start. The program selected is then
indicated with Yes in the Auto Start column.

e3
0b

t6
64

.1
1

Illustration 20.6 Auto Start
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20.2.7 Source Code

Refer to Programmable SyncPos Motion Controller Operating
Instructions.

20.2.8 Edit Source Code

Double-click Program in the right view to view and edit the source code.
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Illustration 20.7 View/Edit Source Code

A range of editing operations are possible, described in detail in the SyncPos manual.
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20.2.9 Save and Exit Program

Select File⇒Save in the menu bar to save the changes to the program file opened from the MCT 10 Set-up Software project.

To leave SyncPos, select File⇒Exit program in the menu bar:
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Illustration 20.8 Exit Program

When editing a configuration file, a SyncPos Application
Closed dialog box pops up. Select Read or Write according
to the instructions in the box.

NOTICE
If there are programs in the SyncPos card, they are
deleted without further warning.
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Illustration 20.9 Confirm SyncPos Write
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20.3 SyncPos Read From Drive

Read all parameters and SyncPos files from a frequency converter to a project by selecting Read from Drive. Select the root
drive and then right-click to find Read from Drive:
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Illustration 20.10 SyncPos Read From Drive

NOTICE
Files in the project can be permanently lost as files of
the same name are overwritten:
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Illustration 20.11 Files Overwritten

Select Yes to commence reading from the frequency
converter and to save configuration files and programs
from the frequency converter to the project.
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20.4 SyncPos Write to Drive

Write all parameters and SyncPos files from a project to a frequency converter by selecting Write to drive. Select the root
drive and then right-click to find Write to drive:
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Illustration 20.12 Write to Drive

NOTICE
Use this feature with caution. If incorrectly used, files on
the frequency converter can be permanently lost. The
following warning appears, explaining that files of the
same name are overwritten:
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Illustration 20.13 Warning Files Overwritten

Select the required settings and select Yes to start writing.
For the above settings, the existing programs are deleted.
Then the SyncPos program source files are written to the
frequency converter. Once the write is complete, check the

contents for the Network folder to confirm that the write
to drive was successful.
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21 Troubleshooting

21.1 Save Error Dialog

When an error dialog appears on the screen, MCT 10 Set-up Software can save to a text file to record the error message for
later reference, for example to obtain help from support. Within the error dialog window, select Save As to record the error
message as a text file with free choice of file name and location.

For example, when scanning the network for frequency converters, an error dialog appears showing the frequency
converters not detected:
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Illustration 21.1 Frequency Converters Not Detected

Select Save As to store the error log. A dialog as shown in Illustration 21.2 appears.
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Illustration 21.2 Store Error Log

21.2 Common Problems and Solutions

21.2.1 Changes Are Not Saved to PC

Check that changes made in the Network folder have been
copied to the Project folder and then saved to a hard disk.
Changes made in the Network folder are implemented in
the field device only and are not automatically saved to a
PC.

21.2.2 Error Message While Installing MCT
10 Set-up Software

A message such as MCT 10 SET-UP SOFTWARE ERROR
OPENING FC DRIVER may occur, if there is another PC
program installed using the same COM port of the PC.
Such a program could be a PLC programming tool, palm
pilot driver, or cellular phone driver. Investigate whether
other programs use the same COM port. If so, ensure that
the other PC tool does not lock or reserve the COM port.
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21.2.3 Error Message Communication Failed

Sporadic communication errors
This type of communication error typically occurs when cables are inadequately shielded, in which case EMC noise can
affect the communication. Check that the cables are installed according to the guidelines in the operating guide for the
frequency converter.

The communication error is permanent
This type of communication error is typically due to an error in network configuration. Check that the network configuration
is in accordance with the frequency converter operating guide.

Communication failed
The Communication failed error message appears in the status bar as shown in Illustration 21.3.
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Illustration 21.3 Error Message: Communication Failed

21.2.4 Communication Errors

If an erroneous/illegal action has been attempted, an error highlight appears in the status bar at the bottom of the MCT 10
Set-up Software window.

When a communication error occurs, the status bar at the bottom of the MCT 10 Set-up Software window is highlighted
and shows a Communication failed error message, as shown in Illustration 21.4.
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Illustration 21.4 Error Message: Communication Failed

When no communication error has occurred, the same window appears as:
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Illustration 21.5 Communication OK
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Communication errors typically occur due to inadequate shielding of cables, that is the cable is not installed in accordance
with the installation instructions.

21.2.5 Help

Select Help⇒Help in the main menu. A help file opens and
shows the MCT 10 Set-up Software manual in .pdf format.
Acrobat Reader software is required to open the manual. It
can be downloaded free of charge at www.adobe.com.

21.3 Safe Plug-in

This section contains common troubleshooting and
descriptions of known errors.

21.3.1 Troubleshooting Communication
Errors

During commission, the communication between MCT 10
Set-up Software and the frequency converter can fail.
Failed communication issues an error message.

Confirm the status of the communication devices and the
frequency converter and the status of the frequency
converter to guarantee proper communication.

21.3.2 Troubleshooting CRC Errors

CRC errors can occur during the write-to-drive procedure.
If a CRC error occurs, try to write to the frequency
converter again.

When the CRC errors persist, verify the integrity of the
devices and communication.
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21.3.3 Device Error Codes

The following is a complete list of all error codes that can appear within the safe plug-in for VLT® Safety Option MCB 15x
Series plug-in and their respective descriptions.

Error
num-
ber

Description

  LED 1 LED 2 LED 4

 Internal failure Reason Action

Status of LED 1 and LED 2 depends on
safety function state assigned to DI1 and DI2

respectively.

Green
constant

1 Diagnostic in
progress

  Green
constant

67 Int fail tolerance
error exceeded:
Reaction STO

• Check that data for
feedback (PPR, type of
feedback, and gear
ratio) is entered
correctly.

• Direction of feedback
is wrong.

• Due to use of
feedback filter, the
dynamic of the system
does not match with
dynamic of feedback
filter
(parameter 42-15 Feedb
ack Filter). System is
ramping too fast.

• Feedback signals are
not received at all.

• No correction
shielding of feedback
cables.

   

• Make a recustomi-
zation with correct
data if needed.

• Set
parameter 42-12 En
coder Direction to
the opposite value.

• Decrease ramping
time on frequency
converter.

• Try to run the
system at, for
example, 60 RPM. If
error number 99
now occurs, this is
the reason.

• Improve shielding
of feedback cables
and motor cables.

     

Red constant

68 Int fail speed
limit SS1a
Ramp: Reaction
STO

• The value of Δ V is too
low. For closed-loop
systems, it must often
be larger than the
recommended value.

• Due to use of
feedback filter, the
dynamic of the system
does not match with
dynamic of feedback
filter
(parameter 42-15 Feedb
ack Filter).

• Load change takes
place during ramping.

   

• If running in closed
loop, try to adjust
PID setting, and if
needed, increase
SS1 ramping time. 

• Try to increase
parameter 42-15 Fee
dback Filter, but
this might cause
error number 67 to
occur.

•  Otherwise increase
parameter 42-45 Del
ta V.

Red constant

69 Int fail speed
limit SS1b
Ramp: Reaction
STO

See 68. See 68. Red constant

Table 21.1 LED Indications
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Error
num-
ber

Description

  LED 1 LED 2 LED 4

 Internal failure Reason Action

Status of LED 1 and LED 2 depends on
safety function state assigned to DI1 and DI2

respectively.

Green
constant

70 Int fail speed
limit SLSa:
Reaction STO

Happens during ramping
to SLS limit, see 68.
Happens during speed
below SLS limit:

• If speed is above
cutoff speed at
activation point and
parameter 42-53 Start
Ramp is set to [0] No,
this error occurs.

• Noise on the feedback
signal (including
quantization noise) is
larger than expected.

• Load change takes
place, do as in above
point.

• Change
parameter 42-53 Sta
rt Ramp to [1] Yes
and set
parameter 42-54 Ra
mp Down Time
accordingly.

• Increase
parameter 42-50 Cu
t Off Speed or
decrease
parameter 42-51 Sp
eed Limit to get a
larger tolerance.

   

Red constant

134 Int fail speed
limit SLSa:
Reaction SS1a

See 70. See 70. Red constant

198 Int fail speed
limit SLSa:
Reaction SS1b

See 70. See 70. Red constant

71 Int fail speed
limit SLSb:
Reaction STO

See 70. See 70. Red constant

135 Int fail speed
limit SLSb:
Reaction SS1a

See 70. See 70. Red constant

199 Int fail speed
limit SLSb:
Reaction SS1b

See 70. See 70. Red constant

72 Int fail processor
failure: Reaction
STO

• The 2 processors on
MCB 15x have
different safety states.

• CPU 2 fails.

   

• First, power cycle
the frequency
converter or restart
the MCB 15x by
parameter 42-90 Res
tart Safe Option.
Secondly, try to
make a general
reset of the MCB
15x with the
Administration
button (MCB 15x
goes back to blank
initial state).

• If the problem
persists, contact
Danfoss.

   

Red constant

Table 21.2 LED Indications

Troubleshooting VLT® Motion Control Tools MCT 10 Set-up Software

176 Danfoss A/S © 12/2017 All rights reserved. MG10RC02

2121



Error
num-
ber

Description

  LED 1 LED 2 LED 4

 Internal failure Reason Action

Status of LED 1 and LED 2 depends on
safety function state assigned to DI1 and DI2

respectively.

Green
constant

73 Int fail-safe
output switch1:
Reaction STO

Diagnostic of safe output
of CPU 1 fails.

• First, power cycle
the frequency
converter or restart
the MCB 15x by
parameter 42-90 Res
tart Safe Option.

• If the problem
persists, contact
Danfoss.

Red constant

74 Int fail-safe
output switch2:
Reaction STO

Diagnostic of safe output
of CPU 2 fails.

• First, power cycle
the frequency
converter or restart
the option by
parameter 42-90 Res
tart Safe Option.

• If the problem
persists, contact
Danfoss.

Red constant

75 Int fail DI2 in
PUST: Reaction
STO

• Safety input connected
to DI2 has illegal
signal level.

• Sensor is broken.

• Check that configu-
ration of DI2
(parameter 42-21 Ty
pe) sub-index [1] is
set correctly or the
connected sensor
is installed
according to
specification.

Red constant

76 Int fail DI1 in
PUST: Reaction
STO

• Safety input connected
to DI1 has illegal
signal level.

• Sensor is broken.

• Check that the
configuration of
DI1
(parameter 42-21 Ty
pe) sub-index [1] is
set correctly or the
connected sensor
is installed
according to the
specification.

Red constant

77 Int fail failsafe
data CRC
mismatch:
Reaction STO

The CRC of the MCB 15x
does not match the
stored CRC value on the
frequency converter.

Configure the MCB
15x with MCT 10 safe
plug-in or by CRC
select/LCP copy.

Red constant

78 Int fail
S1S2CommChan
nel: Reaction
STO

The communication
between CPU 1 and CPU
2 fails.

• First, power cycle
the frequency
converter or restart
the MCB 15x by
parameter 42-90 Res
tart Safe Option.

• If the problem
persists, contact
Danfoss.

Red constant
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Error
num-
ber

Description

  LED 1 LED 2 LED 4

 Internal failure Reason Action

Status of LED 1 and LED 2 depends on
safety function state assigned to DI1 and

DI2, respectively.

Green
constant

79 Int fail no SPI
comm: Reaction
STO

 Contact Danfoss. Red constant

80 Int fail no CAN
comm: Reaction
STO

 Contact Danfoss. Red constant

81 Int fail
undervoltage
Vuc1: Reaction
STO

Voltage for CPU 1 is too
low.

• First, power cycle
the frequency
converter.

• If the problem
persists, contact
Danfoss.

Red constant

82 Int fail
overvoltage
Vuc1: Reaction
STO

Voltage for CPU 1 is too
high.

• First, power cycle
the frequency
converter.

• If the problem
persists, contact
Danfoss.

Red constant

83 Int fail
undervoltage
24 V I/O:
Reaction STO

Voltage for terminal 12
safe output is too low.

• First power cycle
frequency
converter.

• If the problem
persists, contact
Danfoss

Red constant

84 Int fail
overvoltage
24 V I/O:
Reaction STO

Voltage for terminal 12
safe output is too high.

• First, power cycle
the frequency
converter.

• If the problem
persists, contact
Danfoss.

Red constant

85 Int fail
undervoltage
Vuc2: Reaction
STO

Voltage for CPU 2 (GPIO)
is too low.

• First, power cycle
the frequency
converter.

• If the problem
persists, contact
Danfoss.

Red constant

86 Int fail
overvoltage
Vuc2: Reaction
STO

Voltage for CPU 2 (GPIO)
is too high.

• First, power cycle
the frequency
converter.

• If the problem
persists, contact
Danfoss.

Red constant
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Error
num-
ber

Description

  LED 1 LED 2 LED 4

 Internal failure Reason Action

Status of LED 1 and LED 2 depends on
safety function state assigned to DI1 and

DI2, respectively.

Green
constant

87 Int fail
undervoltage
int5v: Reaction
STO

Voltage used for other
circuits than CPU is too
low.

• First, power cycle
the frequency
converter.

• If the problem
persists, contact
Danfoss.

Red constant

88 Int fail
overvoltage
int5v: Reaction
STO

Voltage used for other
circuits than CPU is too
high.

• First, power cycle
the frequency
converter.

• If the problem
persists, contact
Danfoss.

Red constant

89 Int fail memory
fail S2: Reaction
STO

• Data in EEPROM for
CPU 2 is corrupted.

• The flash memory fails.

• Try to perform a
general reset of the
MCB 15x with the
Administration
button.

• If the problem
persists, contact
Danfoss.

Red constant

90 Int fail memory
fail S1: Reaction
STO

• Data in EEPROM for
CPU 1 is corrupted.

• The flash memory fails.

• Try to perform a
general reset of the
MCB 15x with the
Administration
button.

• If the problem
persists, contact
Danfoss.

Red constant

91 Int fail
undervoltage
Vuc2 PLL:
Reaction STO

Voltage for CPU2 (PLL) is
too low.

• First, power cycle
the frequency
converter.

• If the problem
persists, contact
Danfoss.

Red constant

92 Int fail
overvoltage
Vuc2 PLL:
Reaction STO

Voltage for CPU2 (PLL) is
too high.

• First, power cycle
the frequency
converter.

• If the problem
persists, contact
Danfoss.

Red constant

93 Int fail
undervoltage
Vuc2 Core:
Reaction STO

Voltage for CPU2 (Core) is
too low.

• First, power cycle
the frequency
converter.

• If the problem
persists, contact
Danfoss.

Red constant
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Error
num-
ber

Description

  LED 1 LED 2 LED 4

 Internal failure Reason Action

Status of LED 1 and LED 2 depends on
safety function state assigned to DI1 and

DI2, respectively.

Green
constant

94 Int fail
overvoltage
Vuc2 Core:
Reaction STO

Voltage for CPU2 (Core) is
too high.

• First, power cycle
the frequency
converter.

• If the problem
persists, contact
Danfoss.

Red constant

95 Int fail
undervoltage
Vuc2 SDRAM:
Reaction STO

Voltage for CPU2 (SDRAM)
is too low.

• First, power cycle
the frequency
converter.

• If the problem
persists, contact
Danfoss.

Red constant

96 Int fail
overvoltage
Vuc2 SDRAM:
Reaction STO

Voltage for CPU2 (SDRAM)
is too high.

• First, power cycle
the frequency
converter.

• If the problem
persists, contact
Danfoss.

Red constant

97 Int fail MOC fail
S1: Reaction
STO

– • Contact Danfoss. Red constant

98 Int fail invalid
customer file
version

Version of customization
file of MCB 15x stored in
EEPROM does not match
the customization file
supported by the SW
version of MCB 15x.

Do a new configu-
ration with MCT 10
safe plug-in which
supports the SW
version of MCB 15x. 

–

99 Int fail feedback
error

The connected feedback
source does not give any
signal.

Check that the
connection is done
according to the
specification or if the
feedback source is
broken.

Red

113 Ext fail DI1:
Reaction STO

• Safety input connected
to DI1 has illegal
signal level.

• Sensor is broken.

Check that configu-
ration of DI1
(parameter 42-21 Type)
sub-index [0] is set
correctly or the
connected sensor is
installed according to
the specification.

Red constant

Status depends on
safety function state
assigned to DI2.

Red flashing,
cycle (on
500 ms, off
500 ms).

177 Ext fail DI1:
Reaction SS1a

See 113. See 113. Red constant Red flashing,
cycle (on
500 ms, off
500 ms).

241 Ext fail DI1:
Reaction SS1b

See 113. See 113. Red constant Red flashing,
cycle (on
500 ms, off
500 ms).
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Error
num-
ber

Description

  LED 1 LED 2 LED 4

114 Ext fail DI2:
Reaction STO

• Safety input connected
to DI2 has illegal
signal level.

• Sensor is broken.

Check that configu-
ration of DI2
(parameter 42-21 Type)
sub-index [1] is set
correctly or the
connected sensor is
installed according to
the specification.

Status depends on
the safety function
state assigned to DI1.

Red constant Red flashing,
cycle (on
500 ms, off
500 ms).

178 Ext fail DI2:
Reaction SS1a

See 114. See 114. Status depends on
the safety function
state assigned to DI1.

Red constant Red flashing,
cycle (on
500 ms, off
500 ms).

242 Ext fail DI2:
Reaction SS1b

See 114. See 114. Status depends on
the safety function
state assigned to DI1.

Red constant Red flashing,
cycle (on
500 ms, off
500 ms).

115 Ext fail prec
thresh timer
elapsed:
Reaction STO

The frequency converter
has been running below
120 RPM for more than
the time entered in
parameter 42-18 Zero
Speed Timer with safe
function SLS active.

Increase speed to
above 120 RPM.

Status of LED 1 and LED 2 depends on the
safety function state assigned to DI1 and

DI2, respectively.

Red flashing,
cycle (on
500 ms, off
500 ms).

179 Ext fail prec
thresh timer
elapsed:
Reaction SS1a

See 115. See 115. Red flashing,
cycle (on
500 ms, off
500 ms).

243 Ext fail prec
thresh timer
elapsed:
Reaction SS1b

See 115. See 115. Red flashing,
cycle (on
500 ms, off
500 ms).

116 Ext fail SF
activation speed
suspension:
Reaction STO

The frequency converter
has been running below
120 RPM for more than 1
year and a safety function
that needs speed
feedback is activated.

Increase speed to
above 120 RPM.

Red flashing,
cycle (on
500 ms, off
500 ms).

180 Ext fail SF
activation speed
suspension:
Reaction SS1a

See 116. See 116. Red flashing,
cycle (on
500 ms, off
500 ms).

244 Ext fail SF
activation speed
suspension:
Reaction SS1b

See 116. See 116. Red flashing,
cycle (on
500 ms, off
500 ms).

252 Safe option
failure
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